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Overview

1  Overview

GENIUS TOOLS Starter is used to start locally installed applications (for example Creo

Parameteric) using a centrally managed configuration. All required data is synchronized

from a central storage location (Caddepot) to the local computer (Cadpool).

1.1  GENIUS TOOLS Starter philosophy

GENIUS TOOLS Starter lets you manage centrally configured operating environments.

Typically, a company uses one productive operating environment. This operating

environment can be synchronized to all application computers using GENIUS TOOLS Starter.

GENIUS TOOLS Starter also works with multiple operating environments, so that test

environments or environments with customer-specific configurations can be configured

with little effort.

An operating environment can contain any number of projects.

The Startup TOOLS software package includes pre-defined projects for a number of Creo

versions that can be adapted or extended as required by each company. GENIUS TOOLS

Starter also works with publicly available configurations for Creo.

Using synchronization between the administration computer and a number of client

computers, you can manage large and complex installations, distribute central configuration

settings to each Creo workstation and also distribute the required data.

Changes to the configuration are made centrally on the administration computer and are

automatically made available to all users. Different configuration settings can be defined for

user groups, computer groups or units. The software offers global administration

capabilities for heterogeneous IT landscapes and user-specific adaptation options.

1.2  Advantages

– project-oriented workflow

– support for different operating environments

– easy handling through graphical configuration interface for the Creo setup

– central configuration for distributed application computers

– database-driven management of Creo configuration settings

– licensing with FlexLM, fail-safe mode and license borrowing supported

– organization of resources into user groups, computer groups and units

– role-based permission concept
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– Windchill integration

– Creo configuration file management

– blocking or granting of access to projects based on project access groups

– support for multiple languages

– license management

– synchronization based on a configurable interval

– fastest possible Creo Parameteric startup, as all data is stored locally

– easy offline work using license borrowing

1.3  Component modules

GENIUS TOOLS Starter provides user-friendly graphical interfaces for managing the Creo

installation. It consists of three components with separate UIs:

– GENIUS TOOLS Environment Administrator for managing operating environments

– GENIUS TOOLS Project Configurator for configuring projects within an operating

environment

– GENIUS TOOLS Starter App for starting the configured projects

GENIUS TOOLS Environment Administrator

GENIUS TOOLS Environment Administrator provides functionality for managing operating

environments. Use GENIUS TOOLS Environment Administrator to

– create new operating environments

– change properties of an operating environment

– update GENIUS TOOLS Starter and GENIUS TOOLS for Creo in an operating

environment

– configure license servers and synchronization settings

GENIUS TOOLS Environment Administrator is a stand-alone administrative tool. The

executable file gtsa.exe is located in the Installdepot directory.

GENIUS TOOLS Project Configurator

GENIUS TOOLS Project Configurator provides functionality for configuring different Creo

projects with only a few mouse clicks. Projects are provided to the end users for starting an

application using specific configuration settings. Use GENIUS TOOLS Project Configurator to

– define adaptable configuration settings for homogeneous or heterogeneous Creo

landscapes
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– define group-specific settings

– manage different projects

GENIUS TOOLS Project Configurator is started from the user menu of GENIUS TOOLS

Starter App. The administrator can bar users from accessing Project Configurator.

GENIUS TOOLS Starter App

The configured projects are listed in GENIUS TOOLS Starter App for the users to select and

start. The user interface also displays additional information, e.g., available Creo licenses,

working directory and error messages.

GENIUS TOOLS Starter App is a stand-alone tool. The executable file gts.exe is located in the

Caddepot directory under Software.

1.4  GENIUS TOOLS Starter: part of Startup TOOLS

With Startup TOOLS version 6.0, GENIUS TOOLS Starter has been introduced as a stand-

alone tool for managing Creo workstations.
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2  System architecture and terms

2.1  Important terms

The administration computer is a computer on which the administrative user has full

write access to the Caddepot directory in order to manage all data on the file system level. It

is the work station where

– GENIUS TOOLS Environment Administrator is used

– GENIUS TOOLS Project Configurator is used

– the configured projects can be run

Caddepot is a subdirectory of the installation directory. It is the source for the

synchronization of the local work environments on the application computers, that is, the

source for the local Cadpool directories.

The Caddepot directory is shared to be accessible for distributed work.

All work environments that are used locally, via network shares or via synchronization are

managed in the Caddepot.

An operating environment is a directory that contains all the data required for working

with the desktop application. This includes configuration data, libraries, templates and

additional applications. The operating environment also contains a database with all

configured projects. An operating environment can contain an arbitrary number of projects.

If you work locally, the directory you use for your operating environment is the Caddepot. If

you work across a network, the directory for the operating environment is the Caddepot on

the administration computer and the Cadpool on the application computers.

The operating environments contains the software GENIUS TOOLS Starter App (GTS.exe) in

a defined version.

A project is a collection of application properties such as project directory, data directory

and license. Projects allow users to start an application with a specific set of configuration

settings. A project combines locally available data with a centrally managed configuration

settings.

Projects are opened by the users via GENIUS TOOLS Starter App, and edited by the

administrator using GENIUS TOOLS Project Configurator. Each project is saved in a work

environment under cadpool > configuration > projects, e.g., project_creo6p_en.

When a project is started, the configuration settings in the standard directory as well as in

the directories for the unit and for the user are considered.

The central configuration file in Creo is the config.pro file. This file contains all user

configuration settings. GENIUS TOOLS Starter uses a number of configuration file building
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blocks that are then assembled into a config.pro file. Configuration file building blocks in

GENIUS TOOLS Starter are called config_*.pro files, for example,

config_sut_de_c5p_mapkeys.pro or config_sut_de_c6p_dir_file.pro.

2.2  Workflow and synchronization

Standard workflow: Working locally with synchronization

With GENIUS TOOLS Starter, Creo users typically have all the data they need locally on their

workstation. This ensures the fastest possible data access and makes it possible to work

offline.

If the data is copied to the local workstation, it has to be kept up-to-date with data

synchronization. The local data is kept in the operating environment in the Cadpool

directory, which is synchronized with the Caddepot directory, meaning that the data is

copied from Caddepot to Cadpool at a configurable interval.

Data synchronization means that local configuration changes will be overwritten. Changes

to the operating environment, for example entries in a configuration file, have to be copied

manually to the Caddepot. Synchronization has to be paused during the time in which

changes are made. To pause synchronization, open GENIUS TOOLS Project Configurator and

select Pause synchronization from the user menu .

Please note: For data synchronization to work, the users need to have access to the

Caddepot directory. It is recommended to only grant read access if you do not want users

to change settings by themselves.

The setup for working locally with synchronization is created by GENIUS TOOLS Starter by

default. If you start the GTS.exe, it will open from the local Cadpool directory, or create the

Cadpool directory if it does not exist (initial synchronization).

Network mode: Working without synchronization

You can work locally with the data in the Caddepot and without synchronization within a

computer network. To do so, the standard behavior of GENIUS TOOLS Starter has to be

changed and set to network mode, meaning that the GTS.exe will be started in the Caddepot

directory.

To set access rights for network mode, open GENIUS TOOLS Project Configurator and set

Access rights > Function access > Select group > Function access > Prevent switch to local

installation: Yes.
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Way of synchronization from Caddepot to Cadpool in GENIUS TOOLS Starter.

2.2.1  Operating environments

You can manage any number of operating environments with GENIUS TOOLS Starter. This

means that you can have both a test and a production environment installed and manage

environments for different clients.

Each operating environment contains a set of projects, the required data and the GENIUS

TOOLS Starter software. Each operating environment is fully independent of the others.

The directory for the operating environment contains configuration data, libraries and

templates, additional applications as well as the database for project-specific configuration

settings.

Data in an operating environment cannot be changed by setup programs. Changes to an

operating environment and software updates are managed using GENIUS TOOLS

Environment Administrator. This gives the IT administrator better control over which data is
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actually being changed or updated in an operating environment, e.g., GENIUS TOOLS Starter

software, GENIUS TOOLS for Creo, configuration files, or standard parts.

2.3  Directory structure

The directory for an operating environment contains the following subdirectories:

_Images contains an image or images for the operating environment as well as the start

icon. The image and the icon have to use the operating environment name as their file

name. The icon has to be in the icon format (ICO). See also Configuring the desktop link .

_Information contains messages to the users as text files. See also Sending messages to the

users .

apps contains all additional applications for Creo Parametric. The subdirectory ui contains

the freeware tool GENIUS TOOLS UI File Loader. The subdirectory gtfc contains the data for

the GENIUS TOOLS for Creo products Library and/or Parameter, which are part of the

Startup TOOLS software package . 

configuration contains all configuration data for the operating environment, e.g., settings

for units, usergroups and computer groups.

data contains all data directories available in a project, e.g., libraries, materials, ModelCheck

configuration files etc. See also Defining Creo project configurations .

help contains the manuals and installation instructions for GENIUS TOOLS for Creo, GENIUS

TOOLS Starter and Startup TOOLS.

serveronly is only present in the Caddepot directory. It contains additional tools such as

GENIUS TOOLS Comma-to-dot or GENIUS TOOLS Purge. The subdirectory _ErrorLog

contains log files for errors.

software contains the GENIUS TOOLS Starter software

userdata contains user-defined settings, e.g., mapkeys or user images. In contrast to the

directory in configuration/Users, this directory can be managed by the user themselves.

106

113

123

78



11GENIUS TOOLS Starter 
 
                                                                                                                             © 2020 INNEO Solutions GmbH

System architecture and terms

2.4  Configuration concept

As delivered by PTC, Creo does not support settings for different groups of users, for

example for different projects, business units or locations. Creo reads a number of

configuration files that determine the behavior of the application. The central configuration

file is the config.pro. It contains user settings such as appearance of objects and of the

graphics window, units and tolerances, or layers and mapkeys.

GENIUS TOOLS Starter assembles configuration files that can then be applied to project

groups, user groups, computer groups and units. It takes a number of configuration file

building blocks, called config_*.pro files, e.g., config_sut_de_c5p_mapkeys.pro, and

assembles them into a config.pro file that can be read by Creo.

If an option is not specified in the config.pro file, the default value will be used.

2.4.1  Configuration files

The following configuration files determine the settings for a Creo application.

Configuration file Function

config.pro contains settings for a user, e.g.,

– appearance of objects and of the graphics window

– behavior when creating, saving or opening objects

– units, tolerances, search paths and default directories

– printing, import and export settings

– settings for optional modules such as Pro/NC, Pro/Sheetmetal,

Pro/Mold

– layers and mapkeys
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Configuration file Function

config.sup contains settings that the user may not modify, i.e., that cannot be

overwritten by the config.pro file, for example to ensure drawing

standards

config.val contains validation settings for data import

customization.ui contains UI customizations for a user

config_*.pro files are GENIUS TOOLS Starter configuration files. They can be located in four

subdirectories of the configuration directory: standard directory for global system settings,

units/<Unit> for unit-specific settings, projects/<Project> for project-specific settings, and

users/<User> for user-specific settings.

Please note: Configuration files that should be used by GENIUS TOOLS Starter have to

have a file name starting with config_ and a file name extension of .pro, e.g.,

config_sut_de_c6p_dir_file.pro.

2.4.2  Call hierarchy for configuration files

Many configuration options can be set only once in Creo. For such options, the value used is

the last value that is found when reading the config.pro file from top to bottom. If multiple

settings are defined for an option, only the last settings is relevant.

The configuration settings are copied into the config.pro file for Creo in the following

sequence by GENIUS TOOLS Starter.

1. Standard (global directory)

2. Standard searchmode, if Windchill is active

3. Unit (individual unit subdirectory

4. Unit searchmode, if Windchill is active

5. Project (individual project subdirectory)

6. Project searchmode, if Windchill is active

7. User (individual user subdirectory)

8. User searchmode, if Windchill is active

9. Userdata (configurable)

For more information on searchmode, please refer to Searchmode directory .

92

96
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2.4.3  User-driven configuration

Users may manage configuration files on their own and are thus able to overwrite or

append the settings established by the administrator. This is often done, for example, when

working with user-defined mapkeys.

For a user to administer his or her own settings the configuration files have to be saved in

the userdata directory to which the user needs to be given write access. There are two ways

to provide a user with a userdata directory.

1. Users can work in userdata that is a subdirectory of the Caddepot directory of the

adminstrator computer and which is synchronized to the Cadpool directory of the client

computer. 

2. A userdata directory can be set up on any location on the client computer. There, it does

not undergo data synchronization. The storage location has to be defined in

Configuration > (select) group > Creo Settings > Application > User settings >

configuration folder.
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3  License-dependent features

Starting with GENIUS TOOLS Starter 6.0.1, the product functionality depends on the type of

license you are using. From the year 2020 onwards, GENIUS TOOLS Starter is only sold with

subscription licenses.

The following functionality is limited to subscription licenses:

– Configuring units

– Accessing the Windows user management (LDAP / Active Directory)

Warning: If you are using mixed licenses (perpetual and subscription) and configure

functionality that is limited to subscription licenses, the projects in GENIUS TOOLS Starter

App will no longer start if there is no subscription license available.

For information on managing PTC license packages, please refer to Assigning Creo licenses

to projects .85
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4  GENIUS TOOLS Environment

Administrator

GENIUS TOOLS Environment Administrator is an administrative tool for managing

operating environments. Use GENIUS TOOLS Environment Administrator to handle the

following tasks.

– create operating environments (Create)

– add components to an operating environment (Add Components)

– project folders (directories with config.pro and other project-specific files)

– data folders

– additional applications

– update operating environments (GENIUS TOOLS Starter App and GENIUS TOOLS for

Creo) (Update)

– change the settings for an operating environment (Modus)

– license server

– synchronization settings (Caddepot, Cadpool)

– migrate from Startup TOOLS versions prior to 6.0 (Migration)

– convert Startup TOOLS databases (Convert)

The following sections describe the functions of GENIUS TOOLS Environment Administrator.

GENIUS TOOLS Environment Administrator also comes with inline help, which describes the

individual steps and is displayed in the rightmost pane when you use the software.
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4.1  User interface

To access general settings for GENIUS TOOLS Environment Administrator, click on the gear

symbol  in the header.

Language: user interface language

You can switch the user interface language between German and English at any time. The

language setting is saved and will be used the next time you start the software.

The software first starts with a German user interface if the operating system locale is set to

German. For all other locale settings, the software first starts with an English user interface.

Theme: user interface color settings

The software comes with the color themes Blue, Light and Dark. You can switch themes at

any time. The theme setting is saved and will be used the next time you start the software.

Help (F1)

Opens the software help.

About (F12)

Shows the current GENIUS TOOLS Starter version.

Exit

Closes the software. Clicking on the Close button (X) will minimize the program window.
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Step-by-step workflow

When you select a function on the GENIUS TOOLS Environment Administrator start page, a

wizard with one or more dialog pages is displayed. The inline help in the rightmost panel

supports each step of the workflow.

4.2  Creating an operating environment

GENIUS TOOLS Environment Administrator lets you create different operating

environments with only a few mouse clicks. Each operating environment consists of GENIUS

TOOLS Starter App and its accompanying directory structure. You can add new components

at any time, for example, UI and functional configurations for Creo (config.pro, config.sup

config.ui), start object templates, project-specific libraries, drawing frames, ModelCheck

configurations or additional applications (toolkit).

Creating a new operating environment
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The Create wizard lets you start a new, empty operating environment. The new operating

environment consists of the directory structure, the GENIUS TOOLS Starter software, and an

empty sut.db database. Use the  Add Components wizard to add toolkit applications, data

packages or standard projects later on.

Create operating

environment

Creating a new operating environment with GENIUS TOOLS

Environment Administrator

Create wizard: step 1

Click the Create symbol on the start page to start the Create wizard. GENIUS TOOLS

Environment Administrator will find the Caddepot and Installdepot directories automatically

if the software is started from a default installation setup. Verify the paths for the Caddepot

and Installdepot directories and enter a name for the operating environment (1). The name

is used to create a directory of the same name in the Caddepot and setting up the directory

structure there.

Click Next to go on to the next page of the Create wizard.

Please note: You can change the name of an operating environment at any time by just

renaming its directory.
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Creating an operating environment: Step 1

Create wizard: step 2

The users need to connect to GENIUS TOOLS License Manager in order to use a full version

of GENIUS TOOLS Starter App.

Under Source (1), enter the name of the server that GENIUS TOOLS Starter App should

access to get licenses.

Under Synchronization server settings, define the synchronization to keep data current on

the local application computers and give the users fast access to any changes.

The synchronization will not update any toolkit applications as long as Creo is running. For

this to work, the toolkit applications have to be located in the apps directory of GENIUS

TOOLS Starter.

Enter the synchronization server path (2) down to the Caddepot directory. GENIUS TOOLS

Starter App will add the name of the current operating environment automatically. This

makes it possible to copy operating environments, for example to create test environments

quickly without having to change the settings. Also, operating environments can be

renamed without having to change the settings.

Under Target directory (3) enter the location where the Cadpool directory should be located

on the application computers. If the Cadpool directory is not present yet, GENIUS TOOLS

Starter will try to create it. It will also create a subdirectory named for the operating

environment. You can use absolute paths or environment variables that are available on the

application computers.
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Arbeitsumgebung erstellen: Schritt 2

Enter the synchronization interval (4) in minutes. The synchronization interval defines how

often GENIUS TOOLS Starter App should synchronize the data from the central Caddepot. A

synchronization is also run automatically when GENIUS TOOLS Starter App is started.

The best setting for the synchronization interval depends on how often the data is changed

and on how many GENIUS TOOLS Starter Apps are running at the same time. If there are

many changes to the data, the interval should be shorter. If many users are accessing the

Caddepot, the interval could be longer to avoid too much network load due to frequent

synchronizations.

Please note: If you do not configure the synchronization settings, Environment

Administrator will create a local operating environment without synchronization.

4.3  Adding components to an operating

environment

GENIUS TOOLS Starter App can provide the users with data and toolkit applications in

addition to the configuration for the desktop application. The Startup TOOLS product

package contains operating environments with stardardized templates and add-on

applications for Creo (GENIUS TOOLS for Creo). When you create a new operating

environment, an empty directory structure is created and the GENIUS TOOLS Starter
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software is copied. Use the Add Components functionality to add components from the

Installdepot directory to an operating environment.

Add

components to

operating

environment

Examples for operating environment components:

– GENIUS TOOLS for Creo

– project configuration directory for Creo applications

– project data directory for Creo applications

Please note: In order to add components, you first have to install them into the

Installdepot directory from the data setups.

Adding components to an operating environment

Adding components to an operating environment

Add components wizard: step 1

On the first page of the Add components wizard, first select the operating environment you

want to configure (1).

Then select the software version to use (2). Select a software version that has the required

components installed.

Select the CAD application (3) that you want to use the new components with.
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Please note: You can add components to the apps directory. GENIUS TOOLS Starter App

will synchronize additional applications from this directory. Additional apps are only

synchronized when Creo is not running. For example, you can add toolkit applications to

the apps directory. However, there is no way to automatically check which Creo versions

the applications are valid for.

Add components wizard: Step 1

Add components wizard: step 2

On the second page of the Add components wizard, you can create standard projects that

you can later modify using GENIUS TOOLS Project Configurator.

Set or unset the check boxes (1) to define which standard projects should be created.

Double-click on the project name (2) or display name (3) to change it.
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Add components wizard: Step 2

Add components wizard: step 3

On the third page of the Add components wizard, you can add data packages.

Set or unset the check boxes (1) to define which data packages should be added to the

operating environment. Double-click on the display name (2) to change it. The display name

is used as the name of the subdirectory under data. If a subdirectory with this name already

exists, the data package cannot be copied to the operating environment.

Add components wizard: Step

3

Add components wizard: step 4

On the fourth and last page of the Add components wizard, you can select toolkit

applications that should be available in the operating environment.

GENIUS TOOLS Environment Administrator tries to read the name of the toolkit applications

from a protk.dat file. If Environment Administrator finds the name in this file, it is displayed

in the Add components wizard. You cannot edit the target directory. The target directory will

have the same name as the source directory under apps in the Installdepot. If a directory

with this name already exists in the operating environment, the toolkit application cannot be

copied.

To finish the Add components wizard, click Add. All components that you have specified are

added to the operating environment.
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4.4  Updating software

All software setups in GENIUS TOOLS Starter unpack their data to the Installdepot directory.

You can use the Update function of GENIUS TOOLS Environment Administrator to update

the software for GENIUS TOOLS for Creo and GENIUS TOOLS Starter App in the operating

environments. This two-step process allows you to make targeted adjustments to individual

operating environments. You can upgrade or downgrade to any version that is available in

the Installdepot.

Update

software in an

operating

environment

If you have configured synchronization, the configuration for the software update will be

made in the background without the users having to stop Creo or GENIUS TOOLS Starter

App. The new software version will then be used on the application computer after the next

synchronization.

If you update GENIUS TOOLS for Creo, the synchronization on the application computers

will only be run after Creo has been closed.

Warning: If you are using network mode, make sure that all users have closed GENIUS

TOOLS Starter App and Creo, as the software cannot be updated otherwise.

Updating an operating environment
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Updating software in an operating environment

Update wizard

On the first page of the Update wizard, first select the operating environment you want to

configure (1). Then select the new software version (2). Under Update settings (3) you can

select the components to update: GENIUS TOOLS Starter, GENIUS TOOLS for Creo, or both.

Click Update to start the update process.

The update process writes a new software directory for GENIUS TOOLS Starter and updates

the database. For GENIUS TOOLS for Creo, the gtfc directory under apps is re-written. The

main.cfg file remains untouched.

4.5  Changing settings

Some settings for operating environments can only be changed using the Modus wizard in

GENIUS TOOLS Environment Administrator. The most important one of these setting is the

Caddepot path. You can also edit synchronization and licensing settings.
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Please note: GENIUS TOOLS Environment Administrator only changes the standard

settings, that is, the settings for the group Standard. If you have made individual settings

for a user group or computer group, you have to change these settings using GENIUS

TOOLS Project Configurator (Configuration > (select group) > Synchronization)

Changing settings for an

operating environment

Changing settings for an operating environment (Modus)

Modus wizard: step 1

On the first page of the Modus wizard, you can change the license server settings. First,

select the operating environment you want to modify (1). Then enter the license server

settings (2). You can also deactivate the license server. An inactive license server will not be

used by GENIUS TOOLS Starter App. This means that you can only use home-use or

educational Creo licenses.

Modus wizard: Step 1
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Modus wizard: step 2

On the second page of the Modus wizard, you can edit the synchronization settings. The

server path is always given down to the Caddepot directory (1).

When Checksum verification (2) is active, a checksum for each copied file is calculated and

compared to the checksum of the file on the server. If the checksum differs, the server is

queried for the file again. If checksum verification is not active, the files will just be copied.

Warning: Activating checksum verification often allows significantly shorter

synchronization times.

Modus wizard: Step 2

If you have moved your synchronization server, proceed as follows:

1. Create a new Caddepot and adapt the synchronization server settings in the new

operating environment there.

2. Test the new operating environment to make sure that the configuration settings are

correct and the synchronization works.

3. In the old operating environment, switch the synchronization server to the new Caddepot

When GENIUS TOOLS Starter App is restarted, it switches to the new Caddepot and

synchronizes the data from there.
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Warning: Please be extremely careful when changing the Caddepot directory in an

operating environment that is already in use on multiple application computers. Wrong

settings can lead to the application computers not synchronizing. However, it is still

possible to change the Caddepot directory when you move a server. Create a new

Caddepot, then set the synchronization path in the old operating environment to the new

Caddepot. The application computers will switch over accordingly.

Modus wizard: step 3

On the third page of the Modus wizard, you can edit settings for the application computers.

Activate or deactivate synchronization between the central Caddepot and the application

computer Cadpool directories under Activate synchronization (1).

Warning: If you deactivate synchronization, you permanently separate the application

computers from the Caddepot. Any changes you make to the central synchronization

settings or the operating environment will not be transferred to the application

computers!

Under Target directory (2), specify the location of the Cadpool directories on the application

computers, where the local copy of the operating environment is stored. If the Cadpool

directory cannot be found, GENIUS TOOLS Starter will try to create it. A subdirectory named

after the operating environment will also be created. You can use absolute paths such as C:

\Cadpool, or environment variables that are available on the application computers, e.g., %

GTS_SYNC_DESTINATION%.

Under Synchronization interval (3), specify an interval in minutes. The synchronization

interval determines how often GENIUS TOOLS Starter App will synchronize the data. A

synchronization is also run automatically when GENIUS TOOLS Starter App is started.

The best setting for the synchronization interval depends on how often the data is changed

and on how many GENIUS TOOLS Starter Apps are running at the same time. If there are

many changes to the data, the interval should be shorter. If many users are accessing the

Caddepot, the interval could be longer to avoid too much network load due to frequent

synchronizations.

If Start client with Windows (4) is set to Yes, GENIUS TOOLS Starter App will be started

automatically when the operating system is started on the application computers.
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Modus wizard: Step 3

4.6  Migrating a Startup TOOLS environment

Startup TOOLS 2018 and earlier (20xx) are based on a different technology than GENIUS

TOOLS Starter. When you migrate a Startup TOOLS environment, the data from the

specified Startup TOOLS directory are copied to the Caddepot. The database also has to be

migrated and the directory cleaned up. Cleaning up the directory during migration will

never lead to any data loss, as you make any changes to the copied data only, while the

original data remain untouched. This also means that you can work in parallel on GENIUS

TOOLS Starter and on your previous Startup TOOLS 20xx environment.

The migration workflow helps you to use your current configuration setup as a base for the

GENIUS TOOLS Starter configuration. However, manual adaptations may be necessary.

Please note: GENIUS TOOLS Starter does not contain web server functionality. If you

require a web server in your new setup, please install and maintain it separately.

Migration from Startup TOOLS 20xx to GENIUS TOOLS Starter 6.0.

For a thorough description of the migration process, please refer to the separate document

Startup TOOLS-Migration to version 6. The following section gives an overview of the steps

that you have to take in the GENIUS TOOLS Environment Administrator software. We

recommend working on a copy of the Startup TOOLS directory.

Preparations

1. Copy the Startup TOOLS directory. Stop the Startup TOOLS service while you copy.
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Please note: If you cannot stop the Startup TOOLS service for copying the directory, the

ABS databases cannot be copied. Starting with version 6, only one configuration database

is supported. Rename one of the *abs.bak files in the copied data to sut.abs.

2. We recommend cleaning up the copied Startup TOOLS directory and deleting any data

that is not required anymore, such as setups, backup copies etc. This reduces the amount

of data that will have to be synchronized with the application computers.

Migrating a Startup TOOLS 20xx environment

3. Run the software setup for Startup TOOLS 6.x on the administration computer (example

installation path C:\inneo). This step creates the directories caddepot, installdepot and

mediadepot.

4. Open GENIUS TOOLS Environment Administrator and run the function Startup TOOLS

Migration.

Migration wizard: step 1

Under Installation directory, enter the path to your copy of the old Startup TOOLS

installation (stools). The migration wizard will automatically find the Startup TOOLS

installation if it is on the same computer, but you can correct the directory or select another

one.
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Under Select database, select the database sut.abs. If there is no database with this name,

select a database that should be converted.

Migrating Startup TOOLS: Step 1

Migration wizard: step 2

On the second dialog page, specify the Caddepot directory and the operating environment

name, e.g., company-name. The migration will be done in the operating environment

defined here. First, the old Startup TOOLS data will be copied to the operating environment,

then the migration proper will be run. In this way, any changes are made to the copied data

in the new operating environment, and the original data remains untouched.

Under Software, select the Installdepot directory from which to get the GENIUS TOOLS

software. Then select the GENIUS TOOLS Starter version to be used.

Migrating Startup TOOLS: Step 2

Migration wizard: step 3

On the third dialog page, configure the license server and the synchronization server.

Under Source, enter the license server that GENIUS TOOLS Starter App should use to get

licenses. Enter the license server in the format Port@ServerName, e.g.,

7766@<license_server_name>.

Configure the synchronization between the server (Caddepot) and the operating

environment on the local computer (Cadpool). Synchronization to the local Cadpool allows

fast access to the local files. Note that toolkit applications will not be synchronized while

Creo is running. For this to work, the toolkit applications have to be located in the apps

directory of GENIUS TOOLS Starter.

Enter a descriptive server name, then enter the path to the Caddepot on the server.
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Specify the synchronization interval in minutes. The synchronization interval defines how

often GENIUS TOOLS Starter App runs the data synchronization. Additionally, the

synchronization is run automatically when GENIUS TOOLS Starter App is started.

The best setting for the synchronization interval depends on how often the data is changed

and on how many GENIUS TOOLS Starter Apps are running at the same time. If there are

many changes to the data, the interval should be shorter. If many users are accessing the

Caddepot, the interval could be longer to avoid too much network load due to frequent

synchronizations.

Under Target directory, enter the location where the Cadpool directory should be located on

the application computers. If the Cadpool directory is not present yet, GENIUS TOOLS

Starter will try to create it. It will also create a subdirectory named for the operating

environment. You can use absolute paths or environment variables that are available on the

application computers.

Migrating Startup TOOLS: Step 3

Click Migrate to run the migration process. Afterwards, the Caddepot will contain a migrated

operating environment that contains all previously present project configurations.

Please note: The time required for the migration process depends on the amount of

data and on the network connection speed.

4.7  Converting a Startup TOOLS database

Use the function Convert Startup TOOLS Database if you are using a GENIUS TOOLS Starter

or Startup TOOLS version 6.0.0.0 or later and want to convert a database from a previous

Starter or Startup TOOLS yet, use the function Startup TOOLS-Migration instead.

When you convert a Startup TOOLS database, a single ABS database is converted into the

new SQLite format without copying the directory structure.

The Convert wizard corresponds to steps 1 and 3 of the Startup TOOLS Migration wizard.
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Convert wizard: step 1

Under Installation directory, enter the path to your copy of the old Startup TOOLS

installation (stools). The convert wizard will automatically find the Startup TOOLS

installation if it is on the same computer, but you can correct the directory or select another

one.

Under Select database, select the database sut.abs. If there is no database with this name,

select a database that should be converted.

Convert Startup TOOLS database:

Step 1

Convert wizard: step 2

Configure the license server and the synchronization server.

Under Source, enter the license server that GENIUS TOOLS Starter App should use to get

licenses. Enter the license server in the format Port@ServerName, e.g.,

7766@<license_server_name>.

Configure the synchronization between the server (Caddepot) and the operating

environment on the local computer (Cadpool). Enter a descriptive server name, then enter

the path to the Caddepot on the server.

Convert Startup TOOLS database:

Step 2
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Specify the synchronization interval in minutes. The synchronization interval defines how

often GENIUS TOOLS Starter App runs the data synchronization. Additionally, the

synchronization is run automatically when GENIUS TOOLS Starter App is started.

The best setting for the synchronization interval depends on how often the data is changed

and on how many GENIUS TOOLS Starter Apps are running at the same time. If there are

many changes to the data, the interval should be shorter. If many users are accessing the

Caddepot, the interval could be longer to avoid too much network load due to frequent

synchronizations.

Under Target directory, enter the location where the Cadpool directory should be located on

the application computers. If the Cadpool directory is not present yet, GENIUS TOOLS

Starter will try to create it. It will also create a subdirectory named for the operating

environment. You can use absolute paths or environment variables that are available on the

application computers.

Click Convert to start the database conversion.
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5  GENIUS TOOLS Project Configurator

GENIUS TOOLS Project Configurator is the central application for configuring operating

environments. Use GENIUS TOOLS Project Configurator for managing all project and

operating environment settings.

A project is a collection of application properties such as project directory, data directory

and license. Projects allow users to start an application with a specific set of configuration

settings. A project combines locally available data with a centrally managed configuration

settings.

Projects are opened by the users via GENIUS TOOLS Starter App, and edited by the

administrator using GENIUS TOOLS Project Configurator. Each project is saved in a work

environment under cadpool > configuration > projects, e.g., project_creo6p_en.

When a project is started, the configuration settings in the standard directory as well as in

the directories for the unit and for the user are considered.

Project Configurator manages project information by modifying the central sut.db database.

The project configuration for each operating environment can be synchronized to the Creo

application computers.

Please note: Make sure that Project Configurator has write access to the central

database in the Caddepot so that it can store configuration settings.

Project Configurator is not synchronized immediately. When you make changes in Project

Configurator, you have to save them to the database before they become available to

GENIUS TOOLS Starter App. After you have saved your changes, the configuration can be

updated in GENIUS TOOLS Starter App by manually refreshing the available projects or by

running the synchronization process.

5.1  Starting GENIUS TOOLS Project Configurator

GENIUS TOOLS Project Configurator can be started from the installation computer as well

as from any synchronized application computer. On the installation computer, Project

Configurator is located in the Caddepot directory, on the application computers it is located

in the Cadpool directory. In both cases, Project Configurator accesses the same central

database in the Caddepot.

Starting Project Configurator on the installation computer

There are two ways to start Project Configurator: 

1. Open GENIUS TOOLS Starter app via <caddepot>\<environment>\software\GTS.exe. In

the user menu , select Project Configurator (F8) or press F8.
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User menu in GENIUS TOOLS Starter App

1. Start Project Configurator directly using a start parameter:

<cadpool>\<environment>\software\GTS.exe -gts:admin 

Starting Project Configurator on an application computer

There are two ways to start Project Configurator: 

1. Open GENIUS TOOLS Starter app via <caddepot>\<environment>\software\GTS.exe. In

the user menu , select Project Configurator (F8) or press F8.

2. Start Project Configurator directly using a start parameter:

<cadpool>\<environment>\software\GTS.exe -gts:admin 

The item Project Configurator in the user menu can be hidden for the users (see Assigning

access rights ) so they cannot access Project Configurator from the UI. However, the start

parameter -gts:admin can always be used to open Project Configurator.

5.2  User interface and navigation

GENIUS TOOLS Project Configurator opens on the Configuration page  of the main menu

(1) with the Groups and Settings lists. Use the Configuration page to manage global settings

or settings specific to units (with subscription license), computer groups and user groups.

The main menu is located on the left side of the Project Configurator window and lets you

access the pages Configuration , Projects , Resources  and Access rights . You can

show or hide descriptions for the menu items by clicking the menu symbol . For more

information on the main menu pages, please refer to Main menu .

Note that GENIUS TOOLS Project Configurator, in contrast to previous Startup TOOLS

versions, does not save changes immediately. To save any changes, click Save  in the

sidebar. Until you save, any changes can be undone by selecting Revert changes in the user

menu  (2).

The Project Configurator window also has a sidebar (3) and footer (4).

The following sections contain information on the main menu pages and the other control

elements.

104
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5.2.1  Main menu

The main menu is located on the left side of the Project Configurator window and lets you

access the pages Configuration , Projects , Resources  and Access rights .

5.2.1.1  Configuration page

Use the Configuration page (1) to manage global settings or settings specific to units (with

subscription license), computer groups and user groups. The Settings list (3) contains the

following items:

– Network Connections

– GENIUS TOOLS Starter App

– Additional Environmental Settings

– Creo Settings

– Windchill Settings

– Synchronization

– GENIUS TOOLS License Manager

Click one of the list items to open the corresponding settings pane (4) and help (5).
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Project Configurator user interface  

Select a group (2) to show the settings list (3) applicable to this type of group. There are

three types of groups: computer groups , user groups  and units .

The Standard  group is used for managing global settings. In a newly created database,

only the Standard group will be present.

To create a new group, click Create. For more information, please refer to User and

computer groups, units .

For more information on the individual settings, please refer to Configuring global

environments  and Configuring heterogeneous environments .

5.2.1.2  Projects page

Use the Projects page (1) to create and configure projects. The Application type list (2)

contains configurable Creo applications, the Projects list (3) contains configured projects.

These two panes correspond to the project selection that the users will see in GENIUS

TOOLS Starter App.

Projects page

Click a project in the Projects list (3) to open the settings pane for this project with the tabs

Creo (4), Windchill (5) and Environment (6). The corresponding help page is also shown (7).

68
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For information on how to create projects and define their settings, please refer to Creating

projects .

Projects can be accessible to all users of the operating environment, or managed using

project groups, see Working with project groups .

5.2.1.3  Resources page

Use the Resources page (1) to manage the resource types role, user and computer.

Roles

Under Roles (2), you can create and edit roles, that is, named groups of users, computers and

LDAP queries that will be given access to defined projects and GENIUS TOOLS Starter App

functionality, or assigned to a unit. For more information on roles, please refer to Role-

based permission concept .

Users

The Users page (3) displays the configured users in two different views, the card view

(default setting, shown in the screenshot) and the list view, which can be accessed by

clicking the list view symbol (4) to the right of the search field. You can find configured users

via the search field (5).

Users page

To view the projects a user can access, click the Projects symbol  on the user's card (6). To

view the access rights for a user, click the Access rights symbol  on the user's card (7).

To create a new user, double-click on the empty card or fill in the empty entry in the list

view. For more information, please refer to Creating users .

For more information on creating and managing user groups, please refer to User and

computer groups, units  and Assigning users to user groups .
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Computers

Under Computer (8), you can create and edit computers that should be able to access

GENIUS TOOLS Starter. Each computer is identified by its Windows computer name. For

more information on how to create and manage computers, please refer to Creating

computers .

For more information on creating and managing computer groups, please refer to User and

computer groups, units  and Assigning computers to computer groups .

5.2.1.4  Access rights page

Use the Access rights page (1) to access to projects and access to functionality of the GENIUS

TOOLS Starter App.

Function access

Manage access to functionality of the GENIUS TOOLS Starter App by configuring function

access groups (5) under User rights (2) on the Function access (3) page.

The function access groups Everyone and Administrator are pre-configured. For more

information on function access groups, please refer to Access rights .

Project access

Manage access to projects by configuring project access groups under User rights (2) on the

Project access (4) page. For more information on project access groups, please refer to

Working with project access groups .

5.2.2  User menu

To access the user menu, click on the gear symbol in the header .
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Language: user interface language

You can switch the user interface language between German and English at any time. The

language setting is saved and will be used the next time you start the software.

The software first starts with a German user interface if the operating system locale is set to

German. For all other locale settings, the software first starts with an English user interface.

Theme: user interface color settings

The software comes with the color themes Blue, Light and Dark. You can switch themes at

any time. The theme setting is saved and will be used the next time you start the software.

XML Import

You can import users and computers from an XML file. If the users or computers are

assigned to a group that has not yet be configured, the group will also be created during the

XML import. When you click XML Import in the user menu, a dialog for selecting the XML file

is displayed.

XML Export

You can export users and computers into an XML file, for example in order to make batch

changes quickly, then re-import the file.



43GENIUS TOOLS Starter 
 
                                                                                                                             © 2020 INNEO Solutions GmbH

GENIUS TOOLS Project Configurator

Revert changes

Project Configurator does not save changes immediately, so you can revert any unsaved

changes. If you do so, Project Configurator reloads the database and re-initializes all input

fields.

To revert changes, select Revert changes. A warning dialog is displayed. Confirm the

warning (Reload database. Changes will be deleted.) with Yes.

To save changes, click Save in the sidebar (3).

Synchronize now (F8)

GENIUS TOOLS Starter immediately synchronizes from the central Caddepot, regardless of

the specified synchronization interval, and loads any updated files into the Cadpool.

Pause synchronization (F7)

GENIUS TOOLS Starter stops synchronization until it is re-started by the user. The setting

Pause synchronization is saved for the next start and marked by a yellow bar below the

header. When the user resumes synchronization, they are asked whether they want to

resume and overwrite local changes.

Pause synchronization if you want to prevent local changes from being overwritten until

they have been added to the Caddepot by your administrator.

Please note: Your administrator defines whether you can pause the synchronization. If

you are not allowed to pause the synchronization, the item Pause synchronization is not

displayed in the menu.

Sort projects alphabetically

You can sort projects alphabetically by project name. This menu item is only displayed when

the Projects view is active.

Starter App

Switch to the GENIUS TOOLS Starter App.

5.2.3  Sidebar

The sidebar contains the functions Save , Open log file , Open Home  and Online

help .
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Save

Any settings you make in GENIUS TOOLS Project Configurator will only become active after

you save them. As long as you have not saved your changes to the database, you can revert

them by selecting Revert changes in the user menu .

Open log file

Opens the log file that is written on each project start. The log file is saved in the application

computers user directory.

Please note: Please always find and check your log file before opening a call with the

support hotline. The log file is required for troubleshooting any issues.

Open home

Opens the user directory in the file manager.

Online help

Online help opens an internet link to the INNEO Teamviewer software for remote support.

5.2.4  Footer

License mode

The GENIUS TOOLS Starter App footer shows the current license mode by displaying an

icon.

– full version 

– borrowed license 

– failsafe mode 

– educational or home use 

Synchronization mode and synchronization status

To the right of the icon for the license mode, information on the synchronization mode is

displayed. For more information, please refer to Procedures and synchronization .

– Synchronization is active 

Hover the mouse on the synchronization symbol to see the paths to the Caddepot and to

the local operating environment as a tooltip.

– local operating environment without synchronization 

8
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– synchronization of toolkit applications is paused as long as Creo is running 

Messages

RED: Error message. Please troubleshoot.

YELLOW: Warning message. Please decide whether you want to keep on working regardless.

GREEN: Last synchronization run was completed without errors.

Creating shortcuts: This message shows that the desktop link for GENIUS TOOLS Starter

App has been updated.

5.3  Role-based permission concept

Starting with version 6.0.1, GENIUS TOOLS Starter comes with a role-based permission

concept. A role is a group of users and/or computers that can be assigned project access and

access to functionality of GENIUS Starter App in one step.

First, you have to configure roles by defining role membership on the Configuration page

 under Roles. Then you can use the role in the following ways.

1. Control project access

Assign the role to a project access group, see Working with project access groups .

2. Control access to functionality of the GENIUS TOOLS Starter App

Assign the role to a function access group, see Access rights .

3. Defining assignment to a unit

Assign the role to a unit. You can then define unit-specific settings for the Creo applications.

You can use roles to the best effect when you are also using LDAP queries to define

assigned users instead of creating all users individually. This functionality is only available

with subscription licenses. With an LDAP query, you can assign users dynamically. You can

also still assign users and computers statically, meaning that user and computer entries

need to be updated individually. Computers can only be assigned statically, not via LDAP

queries. For more information on using LDAP user management, please refer to Accessing

Windows user management .

You find a graphic on the use of roles in the next chapter (Graphical overview: groups in

Project Configurator) .
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5.4  Graphical overview: groups in Project

Configurator

The graphic gives an overview of the relationships between different types of resources and

groups and also shows where the corresponding configuration is located in Project

Configurator: Configuration , Projects , Resources  and Access rights  pages.

1. Individual computers and users can be assigned to a role as well as to a computer group

or user group.

2. A role is a group of computers and users that are either assigned individually and

statically via Project Configurator, or, in the case of users, dynamically via an LDAP query.

3. A unit always has an assigned role.

4. An access group always has an assigned role.

5. A project access group has an assigned role and one or more assigned projects.

6. Groups and units can be configured with specific settings.
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5.5  Creating resources: users, computers, roles

Use the Resources page to manage the resource types role, user and computer.

Roles are a new concept in GENIUS TOOLS Starter version 6.0.1. A role is a group of users,

computers, and (with a subscription license) LDAP queries  that can be assigned project

access and access to functionality of GENIUS Starter App in one step. To assign a user or a

computer to a role, the user or computer already has to be present in Project Configurator.

To create new users or computers, use the sections Users and Computers on the Resources

page. You can create users and computers manually or import a list, see Importing from

Excel .
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To assign users or computers to groups or units, use the Configuration page, see Assigning

elements to groups or units .

5.5.1  Creating users

To manage users, go to the Resources page  and select Users. Each user is identified by

their Windows user name.

You can switch between the card view (default) (1) and the list view (2), using the list

symbols to the right of the search input box.

Project Configurator saves the active view. User images and assignment to a user group can

only be edited in the list view.

u Card view

The color codes (3)  let you check which access groups each user is assigned to. Click on the

project symbol (4) to see a list of the projects visible for the user. Click on the access rights

symbol  (5) to see the function access rights assigned to the user.

u Searching for users

To find existing users, enter a search term in the search input field (6). A search term has to

be at least three characters long.

u Creating or editing users

To create or edit a user, double-click on a visiting card or go to an entry in the list view. You

need to use the list view for defining a user image and for displaying and editing user group

assignment.
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Card view > edit

user

Blocked

You can block a user, which means that user group settings or role assignment will not be

used.

Yes/set: User group settings or role assignment for this user will not be considered.

No/not set: User group settings and role assignment will be used.

Windows user

Enter the Windows user name. If you are in the list view, you can get the Windows user

name for the currently logged-in user by clicking on the person icon in the Windows user

column.

GTS Alias

Enter a GENIUS TOOLS Starter alias for the user, for use in additional applications. For

example, the GTS alias is used in GENIUS TOOLS Parameter. If you do not specify an alias,

the Windows user name will be set. If you are in the list view, you can get the Windows user

name for the currently logged-in user by clicking on the person icon in the Windows user

column.  The GTS alias is available as an environment variable (%GTS_USER%) in Creo.

GTS Alias Long

Long user alias. The long alias is available in Creo via the environment variable %

GTS_USERLONG%.

GTS Alias Short

Short user alias. The short alias is available in Creo via the environment variable %

GTS_USERSHORT%.

Comment

Enter an optional comment.

Email

Enter the user e-mail address.

Save

Click Save to save your changes to the user data.

Delete

Click Delete in the card view or the recycle bin icon in the list view to delete the user data.

Camera column

The camera column is only available in list view. Double-click on the upload symbol in the

camera column to add a user image.

Group column

The group column is only available in list view. It shows the user group the user is assigned
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to. You can edit the user group assignment. Alternatively, to assign a user to a user group,

go to Configuration > (Select group) > Name / members. (See also Assigning users to user

groups .)

Hint: You can change the configuration for a user by assigning them to a user group.

5.5.2  Creating computers

To manage users, go to the Resources page  and select Computers. Each computer is

identified by its Windows computer name.

u Searching computers

To find existing computers, enter a search term in the search input field (1).

u Creating or editing computers

Blocked (2)

You can block a computer, which means that computer group settings or role assignment

will not be used.

Yes/set: Computer group settings or role assignment for this computer will not be

considered.

No/not set: Computer group settings and role assignment will be used.

Computer name (3)

Enter the Windows computer name. You can get the Windows user name for the current

computer by clicking on the computer icon in the Computer name column.

Group (4)

The group column shows the computer group the computer is assigned to. To assign a

computer to a computer group, go to Configuration > (Select group) > Name / members.

(See also Assigning computers to computer groups .)

Hint: You can change the configuration for a computer by assigning it to a computer

group.

Comment (5)

Enter an optional comment on the computer.

Delete (6)

Click the recycle bin icon to the right of the Comment column to delete a computer.

72

73



51GENIUS TOOLS Starter 
 
                                                                                                                             © 2020 INNEO Solutions GmbH

GENIUS TOOLS Project Configurator

5.5.3  Importing from Excel

GENIUS TOOLS Starter comes with an XML interface to import a large number of users into

the GENIUS TOOLS Starter database in one step. If you want to import users or computers,

please follow the procedure described below.

Format of the Excel table for importing users or computer

The directory caddepot\serveronly\tools\XML-Import contains two Excel tables –

computer.xls and user.xls – that serve as templates for creating XML files for import into the

GENIUS TOOLS Starter database.

Please note: The first line in the Excel table is the header line. The header line must not

be removed and has to be formatted in all capital letters.

Example Excel table for importing computers

Example Excel table for importing users

Enter the name of the computer or user in the first column.

You can use the following columns.

For computers:

– COMPUTERNAME (mandatory)

– DESCRIPTION

– COMPUTERGROUP

For users:

– USERNAME (mandatory)

– ALIAS
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– ALIASLONG

– ALIASSHORT

– USERGROUP

– DESCRIPTION

– EMAIL

Please note: A USERGROUP or COMPUTERGROUP that does not yet exist will be created

on import.

Creating an XML file from the Excel table

After filling in the Excel table, export it from Excel as CSV (comma-separated value) file.

Beispiel: Content of a CSV file with a computer list:

COMPUTERNAME;DESCRIPTION;COMPUTERGROUP

CAD12;TB1;CREO on C:

CAD13;TB1;CREO on C:

CAD14;TB1;CREO on C:

CAD15;TB2;CREO on E:

Please note: The separator character used by Excel depends on your locale. GENIUS

TOOLS Starter supports comma or semicolon as the separator character. You cannot use

either commas or semicolons in the contents of the columns! Please also refer to

Changing the separator for XML conversion .

The directory caddepot\serveronly\tools\XML-Import contains two batch scripts for

converting the CSV files into the XML import format. Use computer.bat for converting

computer lists and user.bat for converting user lists. The CSV file has to be called

computer.csv or user.csv and be located in the same directory as the batch script. When you

run the batch script, the XML import file will be written out as computer.xml or user.xml in

the same directory.

The XML files created by the batch scripts can now be imported into GENIUS TOOLS Project

Configurator. Open Project Configurator, go to the user menu  and select XML import.

Select an XML import file. You will be asked whether you want to delete existing users or

computers. Make your decision. Confirm the import with Yes.

The imported users and computers are now available on the Resources page under Users or

Computers. If the import has created one or more user or computer groups, the groups are

available on the Configuration page in the groups list.

Changing the separator for XML conversion

The separator character used by Excel for CSV export depends on your locale. You can define

the separator character in the batch scripts for CSV-to-XML conversion (computer.bat or
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user.bat) as follows. Comma and semicolon are supported as separator characters (sep) by

default.

csv2xml -v -s:computer.csv -t:computer.xml -sep:;,

-m:1 -xsl:./extend/mode1-stylesheet.xsl 

-alias:eRoot=ROOT,eRecord=RECORD >>result.log

5.5.4  Default roles

To create roles, use the Resources page. There are two pre-configured roles Everyone and

Administrator that you cannot delete.

The role Everyone contains all Windows user names known to the system. You can use the

role Everyone to avoid having to manage all users manually in GENIUS TOOLS Project

Configurator.

The role Administrator also contains all Windows user names known to the system in its

default setting. This means that by default, every user is a member of the role Administrator.

When you first use GENIUS TOOLS Project Configurator, assign some individual users to the

role Administrator and remove the user entry Everyone for this role.

5.5.5  Creating roles

To manage roles, go to the Resources page  and select Roles.

In a next step, a role can be assigned to a unit, a project group or an access group, where

configurations settings take place. (See also role-based permission concept .)

Click Create (1) to create a role. The roles Everyone and Administrator are pre-configured

and cannot be deleted, see Default roles . 

Hint: You can use the role Everyone in order to avoid configuring each individual user. By

default, this role includes all users.

u Role

Role name

Enter a name for the role.

Comment

Enter an optional comment for the role.

5.5.6  Add users and computers to a role

You can add users and computers statically, i. e. the entries you assign to a role do not

change automatically as is the case with an LDAP query .
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Please note: To assign a user or computer to a role, you have to first create an entry in

Resource > Users/Computers.

A user/ computer can be assigned to several roles. 

Follow these steps, using the example of user entries. 

Step 1: Select the role (2) you wish to add users to in Resources > Resource > Role. 

Step 2: In the User tab (3), click add user (4). A new dialog box opens.

Step 3: Select the users you wish to add to the role. If the user you are looking for is not

listed, it has not yet been created under Resources > Users > Edit user. (See also Creating

users .)

You can select the entry Everyone that contains all users.

Step 4: Finish the dialog box by clicking on either:

– Ok: Add selected users and close dialog box,
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– Cancel: Close dialog box without adding selected users,

– Apply: Add selected users without closing dialog box.

Blocked users (5)

A checked box means that a user is blocked, i. e. for this user neither any role nor any group

configuration is applied. To change the blocked status, go to Resources > Users > Edit user.

(See also Block users or computers .)

Delete user (6)

Click the recycle bin icon to the right of the user name.

5.5.7  Accessing Windows user management

If you are using a subscription license, you can access the Windows user management. This

means that you can assign permissions to users and user groups that have been defined by

your company's central IT management. GENIUS TOOLS Starter App uses live queries to

make sure that user assignment is up-to-date. Thus, you do not have to create users locally. 

Windows user management is accessed using LDAP queries. LDAP (lightweight directory

access protocol) is a standard network protocol for accessing a distributed directory service.

Defining an LDAP query

To define an LDAP query, go to the Resources page, select the role that you want to assign a

query to, and go to the LDAP tab.

Defining an LDAP query

 LDAP

Blocked (1)

Use this to block the LDAP query.
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LDAP query (2)

Enter the name of the LDAP group you want to use.

Comment (3)

Enter an optional comment for the LDAP query.

Delete (4)

Deletes the LDAP query from the configuration.

u Modify user

Please note: Changes you make here will not be written back to LDAP.

Blocked (5)

A user can be blocked from the role.

Set: This individual user is not assigned to the role.

Not set: The user is assigned to the role.

Camera column (6)

Double-click the upload icon in the camera column to add a user image.

Windows user (7)

Displays the Windows user name.

GTS Alias (8)

Enter a GENIUS TOOLS Starter alias for use in additonal applications. The alias is available in

Creo via the environment variable %GTS_USER%. If you do not specify an alias, the Windows

user name will be set

GTS Alias Long (9)

Long user alias. The long alias is available in Creo via the environment variable %

GTS_USERLONG%.

GTS Alias Short

Short user alias. The short alias is available in Creo via the environment variable %

GTS_USERSHORT%.

LDAP query

Displays the LDAP group.

Comment

Displays the staff position.

Email

Displays the e-mail address.

5.6  Configuring global environments

The next sections explain the potential of the GENIUS TOOLS Starter configuration option.

This section describes the basic general configuration that is required for each system. This

general configuration is represented by the standard group in the Configuration page.
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The Standard  group for global settings is always present on the Configuration  page.

Please note: The group Standard contains global, system-wide configuration settings.

This group does not have any members, you cannot assign users or computers to it.

Settings that deviate from the global configuration can be defined for computer groups,

user groups and units. For information on how to configure such groups, please refer to

Configuring heterogeneous environments . Additionally, you can define specific settings

for projects, see Creating projects .

The Standard group contains the following settings:

– Network connections

– GENIUS TOOLS Starter App

– Additional environment settings (environment variables)

– Creo settings

– Windchill setttings

– Synchronization settings

– GENIUS TOOLS License Manager

– GENIUS TOOLS Starter App

For more information on how to configure deviations from this global configuration, please

refer to Deviations from the default configuration .

5.6.1  Network drive

u Network drive

Here you can connect a shared network folder that will not be synchronized.

Connect

Specify whether to map the network drive.

Yes: The network drive is mapped when GENIUS TOOLS Starter App is started. If a drive

with the specified drive letter already exists, this drive will be disconnected and then re-

connected according to the configuration, but only if it is not already the drive to be

mapped. This connection will remain active after you stop Creo.
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No: Network drive is not mapped. Use this option if the drive mapping is already

established by other means, such as a Windows login script.

UNC path

Specifies the path to any folder on the server.

Usually given as a UNC path: \\COMPUTER\CreoData.

Drive letter

Assigns a drive letter that the drive is mapped to.

Remap drive

Comparable to the Windows function map network drive.

Yes: After restarting the computer the drive will connect automatically.

No: The drive will not be remapped after a restart.

u User drive

Here you can map an additional user-defined drive.

5.6.2  GENIUS TOOLS Starter App

For information on settings for GENIUS TOOLS Starter App, please refer to Settings for

GENIUS TOOLS Starter App .

5.6.3  Additional environment variables

You can define environment variables that are assigned to the client workstation in a Creo

session under Additional Environment Settings. This allows you to define additional,

company-specific variables that are available after starting Creo without having to use batch

files. For a list of the environment variables created or modified, please refer to the

installation document (GENIUS TOOLS Starter Installation.pdf). The table in the installation

document also lists the corresponding deprecated environment variables, which are still

being generated for compatibility purposes.

Name

Enter the name of the environment variable here.

Value

Enter the value of the environment variable here.

5.6.4  Creo settings
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5.6.4.1  Application

u Startup settings

Creo install path

Enter a directory on the workstation that has Creo installed, e.g. D:\PTC\Creo6.0.

Creo startkey

Specify the PSF files of the respective Creo installation in the directory defined above. You

can either give a file name (parametric.psf) or a complete path 

(D:\PTC\Creo 6.0.2.0\Parametric\bin\parametric1.psf).

Startup folder

Enter the working directory of Creo.

Data folder

Enter the data directory to be used. The data directory is the main directory of an operating

environment containing Creo-related data.

The following data is stored in the data directory:

– Libraries: all library parts and their directories with MNU file

– Configuration:  bend table, search.pro, hole chart, DTL file for drawing representation,

DMT file for colors in Creo, FMT file for displaying parts lists in the browser

– Materials: material files for Creo in the MAT format

– ModelCheck: configuration files for ModelCheck

– NC:  templates and configurations for NC machining.

– Drawings: files for drawing frames, notes and symbols

Please note: The files config_*.pro, config_*.sup and customization.ui can be stored

separately from the data structure due to their potential multiple use. If you want to use

project-specific configuration files, set the folder for them as the project folder in GENIUS

TOOLS Project Configurator > Projects > Creo.

Language

Specify the language in which Creo should run.

<not defined / empty>: The Creo language is defined by a language variable (LANG or

PROLANG) set on the application computer.

System: The locale of the operating system is used. Any language variable (LANG or

PROLANG) set on the application computer is ignored.

<language>: The selectected language is used, and the language variable (LANG or

PROLANG) on the application computer is set to that language.

Windchill user root folder

Specify a directory in which user-specific Windchill data is stored. The directory corresponds

to the Creo favorites folder.

Windchill cache directory

Cache directory for caching of Windchill data. 
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Please note: Try not to modify this option. To change the storage location of the cache,

rather change the setting Windchill user root directory.

Creo Agent home directory 

Directory in which data relevant for Creo Agent, such as server information, is saved. We

recommend setting Creo Agent Home to %PTC_WF_ROOT%.

Enable stop batches

Ja: Additional batch files can be executed after Creo has been stopped.

Nein: No stop batch files can be executed after Creo has been stopped.

u Creo startkey

Synchronize Creo startkey

You can add Creo startkeys (PSF files) for each project in the project directory under

configuration. For each PSF file, a matching BAT file will be created automatically. If you only

want to copy startkeys required for a specific project to the application computers, set Copy

project-related startkey only to Yes.

Yes: Creo startkeys and any startkeys stored in the project directory are copied to the

BIN directory of the Creo installation before project selection.

No: Creo startkeys will not be synchronized to application computers.

Please note: The key synchronization setting is a general settings which will only be

used for a project if the project does not have its own specific key synchronization setting.

Copy project-related startkey only

Only the startkey required for a project is copied. This option can only be used if the above

option Synchronize Creo startkey is set to Yes. 

Yes: Only the startkey relevant to a project is copied.

No: All PSF files stored in the project folder will be copied as startkeys.

u License borrowing

Maximum duration

Specify for how many days licenses may be borrowed at most. Please note that in Creo, the

maximum borrow duration is determined by the environment variable LM_BORROW_DURATION.

Project Configuration does not check whether the value you enter is valid for Creo.

Default duration

Specify the borrow duration in days that is set as the default when a user borrows licenses.

u Plot configuration

Trail folder

Creo trail files, recording all production steps, are written to this directory, e.g. %TEMP%

\Proe.
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Plot configuration folder

This directory contains the configuration files (PCF and PNT) for the plotters, e.g. %

GTS_ROOT_DIR%\configuration\plot.

Plot file folder

Directory on the workstation in which Creo stores the plot files. e.g: C:\Temp.

5.6.4.2  Cleanup

Configuration files of Creo are not overwritten by default. If a new file is to be created, a

previous deletion of the old configuration file is necessary. Here, you can manage the

cleanup settings of GENIUS TOOLS Starter App for Creo projects. 

u Text directory

Define whether following configuration files are deleted or retained in the text directory of a

Creo installation: config.pro, config.sup, customization.ui.

Ja: Delete

Nein: Retain

Please note: Make sure the user has access rights to delete files in the text directory of a

Creo installation. This will be of special importance if Creo is installed in Programs.

u Home directory

Config.pro

Determines whether a config.pro file in the user's home directory is deleted or retained.

Ja: Delete

Nein: Retain

Customization.ui

Determines whether a customization.ui file in the Settings directory in PTC_WF_ROOT is

deleted or retained.

Ja: Delete

Nein: Retain

u Startup directory

Define whether following old configuration files are deleted or retained in the text directory

of a Creo installation: config.pro, customization.ui, config.val.

Ja: Delete

Nein: Retain

5.6.4.3  Write

Configuration files for Creo can be located in three different places, which can affect the

configuration of Creo. Here, you can influence the copy settings of GENIUS TOOLS Starter

and define target directories.
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Warning: A new configuration file will only be written if no configuration file is yet stored

at the location. Use the settings in the Cleanup tab to avoid difficulties.

u Target directories

Config.pro 

Select the directory to which the config.pro file will be copied. If no directory is selected, the

file will be copied to the home directory.

Text: The config.pro file is copied to the text directory of the Creo installation.

Home (Default): The config.pro file is copied to the home directory of the user.

Start: The config.pro file is copied to the startup directory.

Please note: Make sure the user has access rights to create files in the text directory of a

Creo installation. This will be of special importance if Creo is installed in the Programs

directory.

Customization.ui

Select the directory to which the customization.ui file will be copied. If no directory is

selected, the file will be copied to PTC_WF_ROOT.

PTC_WF_ROOT: When existing, the creo_parametric__admin_customization.ui file is

copied to the text directory. The creo_parametric_customization.ui file is copied to the

Settings directory in PTC_WF_ROOT.

Start: When existing, the creo_parametric__admin_customization.ui file is copied to the

text directory. The creo_parametric_customization.ui file is copied to the Creo startup

directory.

Please note: If Creo is to read the customization.ui file from the startup directory, the

following option must be set in the config.pro file: load_ui_customization_run_dir yes.

u Config Handling

Specify whether the following configuration files should be written.

Please note: To copy current configuration files, the corresponding files in the target

directory have to be deleted first (see Cleanup tab). This makes sure that the config.pro

settings defined by the administrator will always be used.

Config.pro

Yes: A config.pro is compiled and copied to the target directory unless a config.pro file

exists there already.

No: Writing config.pro is skipped.

Config.sup

Yes: If a config.sup is found in the project folder, it will be copied to the target directory

unless a config.sup file exists there already.
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No: Writing config.sup is skipped.

Customization.ui

Yes: If a customization.ui is found in the project folder, it will be copied to the target

directory unless a customization.ui file exists there already.

No: Writing customization.ui is skipped.

Config.val

Yes: If a config.val is found in the project folder, it will be copied to the target directory

unless a config.val file exists there already.

No: Writing config.val is skipped.

5.6.5  Windchill settings

The Windchill server registration enables the automatic registration of a Windchill server

under a given name in PTC Creo.

The concept of automatic server registration is that previously registered servers are

retained without changing the entire registration and that a newly registered server is set to

active. It is also part of the concept that server registration does not result in the registered

server reverting to active as soon as a project with the corresponding configuration is

selected. Usually the user wants Windchill settings of the previous Creo session to be set

again after restarting Creo.

Users who are to get access to a Windchill server via automatic server registration need to

have a valid Windchill account and have access to the defined workspace in the defined

Windchill context. It can be useful to create a context (product, library or project) that is not

otherwise used and that these users have access to.

Please note: In order to use automatic server registration, the following requirements

must be met:

– Using Windchill must be activated.

– The Windchill Context must be set and must exist.

– The default workspace must be located in the Windchill Context that is given.

– The Windchill cache directory must be a subdirectory of the Windchill user root folder.

Automatic server registration is configured under configuration > (Select group) > Windchill

settings. The Windchill settings are expanded once you set Use Windchill to Yes.

u General

Use Windchill

Activate/deactivate the Windchill server.

Yes: Activates Windchill-relevant settings such as automatic server registration.

No: Windchill settings will be disregarded.

No, don't register: The Creo session is started without an active Windchill server.

However, the Windchill server remains in the server registry without being selected.
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Windchill server name

Specify the name with which the server will be registered in Creo.

Windchill server URL

Specify the URL under which the server can be reached.

u Register

Server auto register

Select whether the server should be registered automatically.

Yes: The above mentioned Windchill server is automatically registered and is then

available within Creo.

No: The server is not entered automatically.

Server auto rename

If a server already exists at Windchill server URL and has a different name than Windchill

server name, the server will be renamed when starting Creo next.

Set Windchill server online

Select whether the server should be put online.

Yes: A new server that was added by auto-registration will automatically be put online.

No: The server is registered offline.

u Windchill context

Default workspace name

Name of the workspace that is active during registration. The default workspace has to be

present under the context given.

Windchill context type

Type of context: Product, Library, Project.

Windchill context

Context of the workspace.

5.6.6  Synchronization

Synchronization allows for having all important files available locally on the local

workstation. This ensures the fastest possible access to these files. 

No toolkit applications will be synchronized while Creo is running.

Please note: Options that cannot be selected in this dialog box can be changed in GENIUS

TOOLS Environment Administrator.

u General

Activate synchronization

Shows whether synchronization from the Caddepot to the Cadpool directory is active. If

synchronization is suspended, all computers will only operate locally.
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Target directory

Defines the Cadpool directory on the client workstation.

Please note: Changing this entry leads to an initial installation of GENIUS TOOLS Starter

App on the client.

Synchronization interval (minutes)

Specifies the interval at which synchronization is performed in minutes.

Please note: For modifications of the synchronization interval to take effect, GENIUS

TOOLS Starter App has to be restarted.

Start client with windows

Determines whether GENIUS TOOLS Starter App should be started automatically with

Windows. 

Save result to Caddepot directory

Determines whether the result of the synchronization should be transferred to the server.

This includes the end time of the last synchronization, the number of copied files, warnings

and errors. The user needs write access in the Serveronly folder. 

Yes: The result of the synchronization is saved as <hostname>.log in

caddepot\serveronly\_SyncResults.

No: The result is not transferred to the server.

u Server

Checksum validation

Yes: A checksum is determined for each transferred file and matched with the checksum

from the server. If these differ, the file will be requested again.

No: Files are only copied.

Warning: Activating checksum verification can significantly slow data transfer.

Server name

Displays the name of the synchronization server.

Comment

Displays the description for the server.

Server path

The UNC path to the synchronization server.

5.6.7  GTS license server

In order to use the full version of GENIUS TOOLS Starter, you will need a connection to

GENIUS TOOLS License Manager. You can define the server from which GENIUS TOOLS

Starter App should obtain licenses.
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Please note: If no license server is registered or if it is deactivated, only Creo projects that

have an academic or home-use license can be started.

u GENIUS TOOLS License Manager

Active

Activate/deactivate the license server(s).

License server(s)

Enter one or more license servers in the notation Port@Servername (e.g.

7766@<licenseservername>). Separate a series of license servers with semicolons.

Comment

An optional comment on the license server(s).

Hint: The used license server can be found in GT_LIC_SERVER in Creo. You can use this

variable, for example, in GENIUS TOOLS for Creo.

5.7  Configuring heterogeneous environments:

groups and units

IT landscapes very seldom have a homogeneous structure. There are different hardware

setups and different user requirements, so that Creo configuration differences arise

automatically and heterogeneous environments are created. GENIUS TOOLS Starter has

been designed to meet these requirements and makes it possible, to organize similar

configurations into groups or units. In this way, you can define group-specific configurations

for Creo and PTC data management software (e.g., PDM Windchill), as well as make settings

for GENIUS TOOLS Starter App and for data synchronization. Please refer to Deviations from

the default configuration  for an example of how to set a different UI language for Creo

users.

Differences from the default configuration, that is, from the settings in the Standard group,

are defined for computer groups, user groups and units on the Configuration  page. You

can configure computer groups or user groups to reflect hardware-specific or user-specific

requirements, or use units to manage groups of users. Use units if you want to assign users

dynamically via LDAP queries.

76
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Select a group or unit to view the specific Settings. Groups and units come with a separate

settings item Name/Members, which is not available in the Standard group. In contrast, only

the Standard group has the settings item GENIUS TOOLS License Manager.

Please note: If you do not specify a setting for a group or unit, the group or unit will

inherit the setting from the Standard group. (See also Configuring global

environments .)

 Computer groups

Computer groups organize similar hardware setups into groups to allow creating general

configuration settings for this hardware in GENIUS TOOLS Starter. A computer group

should contain all settings for this group that deviate from the general default configuration.

Computers are permanently assigned to a computer group. If a computer has to be added to

or removed from a computer group, you have to change the assignment manually in the

group's settings under Name/Members. (See also Assigning computers to computer

groups .)

Each computer can be assigned to only one computer group.

 User groups

In a concept similar to computer groups, users can be organized into user groups. User

groups are typically used to define function access in GENIUS TOOLS Starter for a certain

number of users, or to define the UI language independently of the hardware used. A user

group should contain all settings for this group that deviate from the general default

configuration.

Users are permanently assigned to a user group. If a user has to be added to or removed

from a user group, you have to change the assignment manually in the group's settings

under Name/Members. (See also Assigning users to user groups .)

Each user can be assigned to only one user group.

56
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 Units

Units are an alternative way of grouping users and assigning group-specific configuration

settings. Units are typically used to reflect organizational structures such as company

departments or sites.

Warning: Using units is a new feature in GENIUS TOOLS Starter from version 6.0.1,

which means that you need a subscription license to use it. Once you have configured

units, you cannot go back to using perpetual licenses.

In contrast to computer groups or user groups, the assignment of users to a unit can be

made dynamically via a role. The role in turn accesses the Windows user management

functionality using LDAP queries. In this way, units always reflect the current staff list and

company organizational structure as configured for Windows user management. If a user

quits a company department, their Windows user account is configured accordingly, and the

user is automatically removed from the corresponding unit. User assignment does not have

to be updated manually.

Please note: To allow a transition phase between managing users and computers

individually and managing them via LDAP queries, users and computers can still be

manually assigned to a unit. However, this is not the recommended procedure for using

units.

A user can be a member of more than one unit. If a user belongs to multiple units, they can

select the unit they want to work with in the user interface of GENIUS TOOLS Starter App

(see chapter Working with units ).

The following sections explain how to work with groups and units and how to add elements

(users or computers) to them.

5.7.1  Create user groups, computer groups and units

To create new user groups, computer groups and units, go to the Configuration page. First,

create the new group or unit, then go to the settings item Name/Members of the new group

or unit to assing computers or users (see Assigning users to user groups ). To create

individual computers or users, go to the Resources page (see Creating resources: users,

computers, roles ).

In contrast to user groups and computer groups, a unit always has to have a role assigned.

Warning: Using units is a new feature in GENIUS TOOLS Starter 6.0.1, which means that

you need a subscription license to use it. Once you have configured units, you cannot go

back to using perpetual licenses. See also License-dependent features .

Step 1: Go to the Configuration  page and click Create under the Groups list.

118
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Step 2: Select the type of group you want to create.

Step 3: Enter a name for the group or unit, as well as an optional comment.

Step 4: Click Create. If you have configured a unit, a warning will be displayed to inform you

that you are using a feature only available with subscription licenses. See also License-

dependent features .

The new group or unit is displayed in the Groups list. Select the new group or unit, go to the

settings item Name/Members, and assign computers or users to the group, or a role to the

unit.

5.7.2  Displaying units in GENIUS TOOLS Starter App

Once a user belongs to multiple units, they have to select a unit in the user interface of

GENIUS TOOLS Starter App.

15
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Units will be displayed in alphabetical order.

Hint: If you wish to place a unit at the top of the list, put a space character in front of the

unit name, e. g. " United Kingdom".

Changes to unit names are adapted after restarting Starter App.

5.7.3  Assigning elements to groups or units

On the Configuration page, select a group that you want to assign computers or users to.

There are three types of groups:

–  units

–  computer groups

–  user groups

For units, computer and users are assigned to via roles.

You cannot assign elements to the group Standard . This group contains system-wide

settings that apply to all users and computers. Therefore, the standard group does not have

the settings item Name/Members, and you cannot change the group's name.

5.7.3.1  Assigning a role to a unit

Units are part of the role-based permission concept. First, assign a group of users to a role,

then assign the role to the unit. A user can be assigned to different units by being a member

of different roles.

In contrast to static user groups and computer groups, unit membership can be dynamic, as

users can be assigned to a role via an LDAP query.

To add elements to a unit, proceed as follows:

Step 1: Go to the Configuration page and select the unit that you want to assign a role to.
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Step 2: Go to the Settings item Name/Members.

Step 3: Edit the unit details as required.

u Unit

Name

Enter the name of the unit.

Comment

Enter an optional comment on the unit.

Blocked

A unit can be blocked in the GENIUS TOOLS Project Configurator. 

Yes: The configuration will be disregarded for this unit.

No: The configuration will be applied.

Please note: Block a unit in Project Configurator if you do not want to apply the unit

configuration, but want to keep the unit. You can also block individual users or computers

without blocking the entire unit. Please refer to Block users or computers .

u Definition

Unit directory

Select a directory for unit-specific data (under configuration > units).

Role

Select a role to assign a group of users to the unit. Roles can be added in Resources > Roles.

75
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u LDAP  – User – Computer

This section shows the users and computers assigned to the role. To assign elements to a

role, go to Resources > Roles > Select role. 

If the checkbox before the user or computer name is set, the corresponding user or

computer is locked. To make changes to the lock status, go to Resources > Users > Create or

edit user, or to Resources > Roles > Select role > LDAP. (See also Block users or

computers .)

When assigning a role to a unit, the LDAP query for the role is displayed for your

information but cannot be accessed..

5.7.3.2  Assigning users to user groups

When you assign a user to a user group, the configuration settings for the user group will

apply to that user.

Please note: Each user can only be assigned to one user group.

To assign a user to a user group, either use the list view for users under Resources > Users,

or edit the members of the user group under Configuration > Groups.

Step 1: Go to the Configuration page and select the user group  that you want to add

users to from the Groups list.

Step 2: Go to the Settings item Name/Members.

Step 3: Under Members click on Add user.

Step 4: Select the users you wish to add to the group. If the user you are looking for is not

listed, it has not been configured under Resources > Users > Edit user. (See also Creating

users .)

Step 5: Finish the dialog box by clicking on either:

– Ok: Add selected users and close dialog box,

– Cancel: Close dialog box without adding selected users,

75
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– Apply: Add selected users without closing dialog box.

5.7.3.3  Assigning computers to computer groups

Each computer is identified by its Windows computer name. When you assign a computer to

a computer group, the configuration settings for the computer group will apply to that

computer.

Please note: Each computer can only be assigned to one computer group.

Step 1: Go to the Configuration page and select the computer group that you want to add

computers to from the Groups list.

Step 2: Go to the Settings item Name/Members.

Step 3: Under Members click on Add computer.

Step 4: Select the computers you wish to add to the group. If the computer you are looking

for is not listed, it has not been configured under Resources > Computers > Edit computer.

(See also Creating computers .)

Step 5: Finish the dialog box by clicking on either:

– Ok: Add selected computers and close dialog box,

– Cancel: Close dialog box without adding selected computers,

– Apply: Add selected computers without closing dialog box.

50
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5.7.4  Remove users and computers from a group

To remove a computer from a computer group go to the item Members in Configuration 

 > (select) Computer group  > Name/Members and click the recycle bin icon  on the

right of the computer name.

To remove a user from a group, select the respective user group  in the Configuration

page  and click the recycle bin icon  on the right of the user name.

5.7.5  Deactivate user and computer groups

You may want to deactivate a user or computer group in Project Configurator if you do not

want to apply the group configuration without deleting the group altogether. 

To deactivate a computer group  go to Configuration > (select) Computer group >

Name/Member and select the item Blocked.

Yes: The configuration will be disregarded for this computer group.

No: The configuration will be applied.

Deactivate computer group

To deactivate a user group  go to Configuration > (select) User group > Name/Member

and select the item Blocked.
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You can also block individual users and computers without blocking the entire group. Please

refer to Block users or computers .

5.7.6  Blocking individual users or computers

Individual computers or users can be blocked. Settings made for these computers or users

in GENIUS TOOLS Project Configurator will not be applied, that is, the system-wide general

settings will be used for blocked computers or users.

Block a computer, for example, if you want to keep it assigned to a group, but temporarily

want to disable the group's settings for this computer.

Blocking a user or computer lets you test the system-wide general settings defined in the

standard group by disabling any overlying user- or computer-specific settings.

To block individual computers, go to Resources > Computers > Edit/create computer.

A blocked computer

To block individual users, go to Resources > Users > Edit/create user. You have to use the list

view.

A blocked user

You can also block an entire computer group or user group. Block a group if you want to

keep the group configuration, but temporarily do not want to apply its settings. To block a

group, go to Configuration > (Select group) > Settings item Name/Members. (See also

Assigning elements to groups or units .)

75
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5.8  Deviations from the default configuration

This sections explains how to define a UI language as a user-defined setting as an example

for configuration deviations.

5.8.1  User-defined language

Before Creo start, the Creo UI language can be set to one of the following: English, German,

Italian, French, Spanish, Japanese, Chinese (Simplified), Chinese (Traditional), Korean,

Russian, Brazilian Portuguese. The languages are provided for Creo by PTC.

Please note: GENIUS TOOLS Starter does not influence the way different locale settings

interact. For information on supported settings, please refer to the PTC website or the

product documentation.

The UI language for Creo can be defined on four different levels in GENIUS TOOLS Project

Configurator:

1. System-wide: Configuration > Group: Standard > Creo settings > Startup settings >

Language

2. Unit: Configuration > Select unit > Creo settings > Startup settings > Language

3. Group: Configuration > Select group > Creo settings > Startup settings > Language

4. Project: Projects > Select project > Creo tab > Startup settings > Language

The following example procedure refers to group settings.

Example: Setting the UI language for a user via a user group

Starting situation:

– A company is located in Germany.

– A British designer is tasked with working on a project with the company in Germany for

a time of four weeks.

Procedure:

1. The system-wide setting for the Creo language is German. This is defined under

Configuration > Standard group > Creo settings > Startup settings in the Language

drop-down menu.
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2. Go to the Resources page, select Users and configure a new user with the Windows user

name for the British colleague.

3. Go to the Configuration page and create a new user group, calling it, for example,

Guests.

4. Select the new user group, go to the settings item Name/Members > Add user. Add the

user you have configured to the new user group.

5. Select the new user group, go to the settings item Creo settings and, under Startup

settings > Language, select English.

5.9  Creating projects

Use GENIUS TOOLS Project Configurator to define configuration settings for Creo projects

with only a few clicks. You can distribute a company-specific or commercially available

environment to all workstations where it is needed. The projects you define are listed for the

Creo users in GENIUS TOOLS Starter app. The user can select and start a project from the

list.

A project consists of the following components

– a defined Creo release or weekly version

– interface and functional configuration files for Creo (config.pro, config.ui)

– start object templates

– project libraries

– drawing frames

– ModelCheck configurations

– additional applications (Toolkit)

– and many other settings relevant to working with Creo

Projects can also be used to assign Creo licenses to defined application computers or users,

see Assigning Creo licenses to projects .85
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Each project can have an individually defined directory structure to house its component

files. Additional applications or scripts can also be integrated into a project.

5.9.1  Defining Creo project configurations

A project environment consists of the following information:

– Creo Parameteric release and version to be used

– licenses to be used (startkeys, PSF files)

– configuration settings in configuration files

– user interface settings in UI files

– additional applications

– settings and link-ups for additional applications (batch files)

– Windchill availability in the Creo Parametric session

– plot settings

– additional required data:

– data referenced in the configuration files (colors, materials, templates etc. in the data

directory)

– data for other tasks (information documents, additional tools)

A project configuration consists of Creo object data – filed in the data directoy – and Creo

configuration files, which can be filed in any of the project-relevant directories standard,

unit, project and user. Separating the Creo object data from the Creo configuration data and

the additional applications ensures that Creo objects in an operating environment can be

used in multiple projects.

Settings for a project environment come from the following directories standard, unit,

project and user. (See also chapter on the call hierarchy. )

1. Data directory:

<GTS-operatingenvironment>\data

2. Project directory:

<GTS-operatingenvironment>\configuration\projects\%GTS_PROJECT_DIR%

3. Unit directory:

<GTS-operatingenvironment>\configuration\units\%GTS_UNIT_DIR_NAME%

4. User directory: 

<GTS-operatingenvironment>\configuration\user\%USERNAME%

Data directory

The data directory is the main directory for data specific to an operating environment. All

Creo object data is stored in subdirectories for each operating environment, for example

<GTS_ROOT_DIR>\data\sut_int_de_creo6.

The Creo data is stored in the following directory structure within the data directory:

12
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Data

directory

– config: bend table, search.pro, hole chart, DTL file for drawing representation, DMT file

for colors in Creo, FMT file for displaying parts lists in the browser

– library_dir: all library parts and their directories with MNU file.

– material_dir: material files for Creo in the MAT format

– modelcheck_dir: configuration files for ModelCheck

– nc_dir: templates and configurations for NC machining

– Drawings (texture): files for drawing frames, notes and symbols

All references to data in the data directory are defined in project configuration files, i.e., in a

config_*.pro file in the projects directory. If there are no project-specific references, the

general configuration files in the standard directory will be used, i.e., the config_*.pro files

under <GTS-OperatingEnv>\standard.

Warning: Starting with GENIUS TOOLS Starter 6.0.1, a new configuration mechanism is

in use. When you update from version 6.0.0.0 or migrate from Startup TOOLS 20xx, the

files in the projects directory, that is, the general configuration files, will be moved to a

new directory named standard. Project-specific configuration files located in

subdirectories under projects will not be moved.

It is recommended to consistently use variables in your references. For example, a reference

to a data directory from a config_*.pro uses the variable $GTS_DATA.

Example: A reference in the configuration file config_sut_de_c6p_dir_file.pro in the project

directory project_creo6p_de reads

pro_library_dir $GTS_DATA\library_dir

This reference points to the directory library_dir within the data directory.

Hint: It is recommended to use variables where possible.

Please note: Many configuration options can be set only once in Creo. In this case, the

value of the latest entry is used, that is, the value from the file that is copied last. There is

a defined call hierarchy for the files, see Call hierarchy .12



80GENIUS TOOLS Starter 
 
                                                                                                                             © 2020 INNEO Solutions GmbH

GENIUS TOOLS Project Configurator

Project directory

The project directory defines which Creo operating environment is loaded. The project

directory houses all relevant Creo configuration files, i.e., config_*.pro, config_*.sup,

customization_*_.ui and config_*.val.

The configuration files can be placed in the standard directory for all projects (<GTS-

OperatingEnv>configuration\standard), or in the project-specific directories that are created

automatically with each new project, e.g., <GTS-

OperatingEnv>configuration\projects\project_creo5p_en. When you configure a project,

you can point to a project-specific directory for the configuration files. If you do not

configure a project-specific directory, the global configuration settings from the standard

directory will be used.

You can also place batch files both in the standard directory and in the project-specific

directory. The batch files will be run before starting the software. For more information on

batch files, please refer to Configuring an operating environment with batch files .

Warning: Starting with GENIUS TOOLS Starter 6.0.1, a new configuration mechanism is

in use. When you update from version 6.0.0.0 or migrate from Startup TOOLS 20xx, verify

references to configuration files in your batch files. References to 

..\configuration\projects\ have to be changed to ..\configuration\standard.

Batch files in the project-specific subdirectories under projects do not have to be changed.

Unit directory

The unit directory defines which Creo operating environment is loaded. The unit directory

houses all relevant Creo configuration files, i.e., config_*.pro, config_*.sup,

customization_*_.ui and config_*.val.

You can place batch files in the unit-specific directory. The batch files will be run before

starting the software. For more information on batch files, please refer to Configuring an

operating environment with batch files .

Specifying the Creo installation directory

There are three different ways of configuring the Creo installation directory and start

command:

1. On the Project Configurator Configuration page for the standard group or another group

or unit: Configuration > Select group > Creo settings > Creo install path

2. In the GENIUS TOOLS Starter project: Projects > Select project > Creo > Release > Given

path

3. Via the local Windows registry on the application computer: Projects > Select project >

Creo > Release > Select Creo version
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Depending on your requirements, each way of defining the installation directory can make

sense.

Please note: In general, it is recommenden to determine the installation path via the

local Windows registry.

Consider the following criteria:

1. If you want to make sure that each application computer throughout your company uses

the same Creo version, configure the Creo installation directory via the Configuration

page. In this way, you will not have to specify it for each project.

2. If a variety of versions or weekly versions is in use, for example because you are

providing services for different customers, configure the Creo installation directory in

each project.

3. If local installations are inconsistent or not known in detail, fall back on the local Windows

registry to determine the Creo installation directory. You can specify which Creo version

to look for, the highest weekly version for which will be used.

5.9.2  Creating a new project

To create a new project, go to the Projects page  and click Create (1). A new project (3) is

shown in the list with the name New Project and a number if there already is a project of the

same name. The new project becomes visible to the users as soon as you save your changes

to the database.

You can create projects for all applications listed under Application type.

Click on a project in the projects list to edit the project details in the right pane. Note that

there are three tabs with project details: Creo (4), Windchill (5) and Environment (6).

Some input fields are preset, others come with a browse button to define directory paths.

Optional fields are given in brackets in the following description. If you do not specify the
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optional settings, the general settings for the standard group or the settings you may have

made for the unit, computer group, or user group, will be inherited by the project.

First, specify general project properties (7) in the Creo tab (4).

View and project group settings

5.9.3  Displaying projects to users

Projects are displayed to user in GENIUS TOOLS Starter App like this:

Settings for project display, such as the project image and info text, are made under Projects

> Select application > Select project > Creo > General.

u General

Project name

A unique name without space characters that identifies a project, e.g. project_creo6p_en.

The default setting New Project can be overwritten. The project name can be changed at any

time.

Display name

A unique name that is displayed for the users in GENIUS TOOLS Starter App. In GENIUS

TOOLS Starter App, the projects will be listed alphabetically according to their display name.

Information (optional)

Short text describing the project. The information text will be shown below the display

name.

Project image (optional)

A picture that is displayed for the project in GENIUS TOOLS Starter App. Use PNG or JPEG

files.

Use project access groups

Projects can be restricted to users who belong to a defined project access group with

specific access rights. Members of a project group can only view in GENIUS TOOLS Starter

App the projects they have access to. See chapter Using project access groups. 91



83GENIUS TOOLS Starter 
 
                                                                                                                             © 2020 INNEO Solutions GmbH

GENIUS TOOLS Project Configurator

Yes: Shows whether the project is assigned to at least one project access group. Use

project groups is set to Yes automatically when a project is assigned to a project access

group.

No (Default): The project is available to all users.

5.9.4  Hiding and blocking projects

Projects that shall not be displayed to the user in GENIUS TOOLS Starter App can be hidden

in Projects > Application Type > Projects > Creo > General.

When you set Hide project to Yes, the project is not listed in GENIUS TOOLS Starter App, but

can still be started using a start parameter. This can be a useful option for Windchill projects,

for example.

Hide project

Yes: The project is not displayed on the user interface in GENIUS TOOLS Starter App, but

can be selected using the -gts:p:<project name> start parameter. 

No (Default): The project is listed in the UI.

A blocked project, by contrast, cannot be started using a start parameter.

Block project 

Yes: The project is not displayed and cannot be accessed on the application computer.

No (Default): The project can be accessed.
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5.9.5  Settings for Creo projects

After you have created a new project, specify the following settings in the Creo tab.

Note on Creo APP: Starting with Creo 1, different applications in the Creo family access the

same information, which is placed in a common directory structure on installation. The basic

libraries for Creo Parametric and Creo Direct are identical. This also holds for other

applications, called APPs for short. When you configure a new Creo project, set the Creo APP

option to determine which application to start.

u Creo

Creo APP

Defines the Creo APP, e.g. Creo Parametric, Direct, Simulate or Layout.

Release

Defines the Creo version to be used. A Creo path can be configured, or determined

automatically from the registry of the application computer.

Fixed path: Enter the Creo directory, which may differ from the Creo directory for the

standard group as defined on the Configuration page. If you do not specify a Creo

directory, the settings for the standard group will be used (see Configuration > Standard

> Creo settings > Startup settings).

Creo versions: Select a Creo version. If you select Creo 6, for example, the installation

directory for the latest Creo 6 release on the application computer will be determined

from the registry.

Please note: Creo has to be installed locally on the application computer in order to have

registry entries available. The user has to have read permission in HKLM.

Lowest shipcode (optional)

Lowest usable weekly version. There is a dropdown list for versions up to Creo 4. Starting

with Creo 5, enter the required version manually in a four-digit format like 6.0.1.0.

Highest shipcode (optional)

Highest usable weekly version. There is a dropdown list for versions up to Creo 4. Starting

with Creo 5, enter the required version manually in a four-digit format like 6.0.1.0.

Project folder (optional)

Folder in configuration\projects. The files config.pro, config.sup, customization.ui and

config.val are copied as templates from this directory to the application computer.

Data folder (optional)

Main directory of an operating environment to which Creo-related data is saved.
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Please note: The files config.pro, config.sup and customization.ui should be stored

separately from the data structure due to their potential multiple use. These configuration

files should be managed in the specific subdirectories of the configuration directories

Units, Projects, or Users, or in the Standard directory for global settings.

u Startup settings

Startup folder

Enter the startup directory.

The remaining entries are listed in the next chapter Assigning Creo licenses to projects

und in Language of a Creo project.

5.9.6  Assigning Creo licenses to projects

This section describes the recommended procedure for assigning defined Creo license

packages to individual application computers.

Licenses are always organized by the Creo setup. For more information, please refer to the

PTC product documentation for Creo.

During PTC setup, multiple startkeys can be created. Each startkey should be linked to a

defined license package. Choose the name of the startkey so that you recognize which

license package it uses. After you have generated the required startkeys, you can configure

the corresponding projects in Project Configurator. Choose the project name so that you

recognize which license package the project uses.

Assign the startkey that corresponds to a license package to a project under Projects > Select

project > Creo (tab) > Startup settings.
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u Startup settings

Startkey

The PSF files of the respective Creo installation. The directory of the Creo installation is

defined above under Release. You can also overwrite the default setting (e.g. parametric.psf)

and specify a path here, such as D:\PTC\Creo6\bin\proel.psf

Please note: If a defined startkey is not available on the client computer, you can choose

to display the project in GENIUS TOOLS Starter App as follow (Go to Configuration >

Groups > GENIUS TOOLS Starter App > Projects > Display invalid projects):

– Display with error warning: Project without a valid license is displayed with a red

background and cannot be started. (Select Yes, as error)

– Project is not displayed. (Select No)

Sync startkey

Yes: The start key (PSF) is copied from the project folder to the Creo BIN directory.

No: The start key is not copied, even if system-wide synchronization has been set up.

Please note: For this option, write permissions are required on the application computer

in the Creo BIN directory.

Please note: Take care when synchronizing startkeys. A configuration error may lead to

erroneous distribution of startkeys to application computers that should not have defined

licenses available.

Startup folder

Enter the startup directory.

License borrowing

You can define the maximum duration of borrowing PTC and GENIUS TOOLS licences in

Projects > Select project > Creo (tab) > License borrowing.

Maximum duration

Specify for how many days licenses may be borrowed at most. Please note that in Creo, the

maximum borrow duration is determined by the environment variable LM_BORROW_DURATION.

Project Configuration does not check whether the value you enter is valid for Creo.

Default duration

Specify the borrow duration in days that is set as the default when a user borrows licenses.
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5.9.7  Language of a Creo project

The language, in which Creo runs, can be set in Projects main page under Application type >

Projects > Creo (tab) > Startup settings. 

The following languages are available: English, German, Italian, French, Spanish, Japanese,

Chinese (simplified), Chinese (traditional), Korean, Russian, Brazilian Portugese. Choose one

of the following setting:

<not defined / empty>: The Creo language is defined by a language variable (LANG or

PROLANG) set on the application computer.

System: The locale of the operating system is used. Any language variable (LANG or

PROLANG) set on the application computer is ignored.

<language>: The selectected language is used, and the language variable (LANG or

PROLANG) on the application computer is set to that language.

5.9.8  Workspace for Windchill

Set workspace directories for Windchill and Creo under Workspace in the Creo tab.

u Workspace

Windchill user root directory

Enter the PTC_WF_ROOT directory to which the workspace and user-defined settings can be

saved.

Please note: If you want to specify separate Windchill directories for various Creo

versions you can use variables like %GTS_PRORELEASE%, which will resolve to the Creo

version, e.g., Creo6, or %GTS_PROJECT_NAME% in building your path.

Windchill cache directory 

Cache directory for caching of Windchill data. To use automated server registration, the

Windchill cache directory has to be under the Windchill user root directory, see Automatic

Windchill server registration .

Please note: Try not to modify this option. To change the storage location of the cache,

rather change the setting Windchill user root directory.

Creo Agent home directory 

Directory in which data relevant for Creo Agent, such as server information, is saved. We

recommend setting Creo Agent Home to %PTC_WF_ROOT%.

100
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Please note: If you want to specify separate Windchill directories for various Creo

versions you can use variables like %GTS_PRORELEASE%, which will resolve to the Creo

version, e.g., Creo6, or %GTS_PROJECT_NAME% in building your path.

Dynamic server settings for different Creo versions

When you change the Creo version, the local cache directories should be deleted from the

disk and re-created with the current Creo version. This means that when you use different

Creo versions, you also need to create different cache directories. Also, the storage location

for Windchill server registration information should be different.

There are two ways to ensure separate cache and server registration storage for different

projects:

1. Configure independent Windchill user root directories for different projects.

2. Use variables in configuring the Windchill user root directory.

The following variables can typically be used:

Variable Description

%

GTS_PROERELE

ASE%

Returns the Creo version as Creo3, Creo4 etc.

%

GTS_PROJECT_N

AME%

Returns the project name

%username% Returns the name of the Windows user

%

computername

%

Returns the computer name

These variables can be used in the setting the path for the Windchill user root directory.

Example: D:\ptc\workspaces\%username%\

%GTS_PROERELEASE%\%GTS_PROJECT_NAME%

The Creo Agent home directory, where server registration information is saved, schould also

depend on the Windchill user root directory. To set this up, you can define a variable for the

Windchill user root directory under Configuration > Standard > Additional Environment

Settings.

Name Value
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Creo Agent

Home 

%PTC_WF_ROOT%

Making the Windchill user root directory dependent on the Creo version by using %

GTS_PROERELEASE% and making the Creo Agent home directory dependent on that via %

PTC_WF_ROOT% will lead to all server information and data being stored separately per

version.

If you also make the Windchill user root directory dependent on the project name using %

GTS_PROJECT_NAME%, the storage location will be project-dependent and will change with a

new Creo version.

Do not use %GTS_PROJECT_NAME% if you use GENIUS TOOLS Starter projects to manage

different Creo license packages, because you cannot use local workspaces for multiple

projects in this way.

5.10  Working with project access groups

Project access groups limit access to configured projects to a defined group of users.

Projects that are not assigned to any project access group are accessible for all users.

A user can be a member of any number of project access groups. The user will be able to

access all projects assigned to a project access group of which they are a member.

Please note: Each user can only see the projects they are permitted to access. To verify

which projects are accessible for a certain user, go to the card view under Resources >

Users and click on the project symbol  on the user's card.

5.10.1  Creating project access groups

To limit access to projects to defined groups of users, you first have to create a project

access group. Go to the Access rights page (1), then click Project access (2). Click Create (3)

under the Groups list. A new item New Project Group is displayed in the Groups list (4).
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A newly created project access group does not have any users or projects assigned. Enter

the settings for the new project access group.

u Project access group details (5)

Group name

Enter a name for the project access group. 

Comment

Optionally, enter a comment to describe the project access group.

u Projects (6)

Add project

Assign projects to the project access group. Note that assigning a project automatically sets

the option Use project groups for the project (Projects page, > Creo tab > General).

Please note: The option Use project groups is set automatically when you assign a

project to a project access group. However, if you want to change the project back to

general access without project access groups, you have to change the setting to No

manually under Projects page > Creo tab > General.

u Members (7)

Role

Select the role.
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u LDAP  – User – Computer

This section shows the users and computers assigned to the role. To assign elements to a

role, go to Resources > Roles > Select role. 

If the checkbox before the user or computer name is set, the corresponding user or

computer is locked. To make changes to the lock status, go to Resources > Users > Create or

edit user, or to Resources > Roles > Select role > LDAP. (See also Block users or

computers .)

5.10.2  Using project access groups

When you assign a project to a project access group, the option Use project groups under

Projects page > Creo tab > General is set automatically to change the project access mode

to group access. 

Project access mode (Projects > Creo > General)

Please note: If you manually set the Use project groups option to Yes without assigning

the project to a project access group, the project will not be visible for any user because it

cannot be linked to any project access group. It is best to rely on the automatic change of

this option to Yes.

5.10.3  General project access

If you want to change a project back to general access without project access groups, you

have to change the Use project groups option to No (Projects page > Creo tab > General).

To make a project accessible to all users, it is not sufficient to remove it from all project

access groups. To switch back to general access, you have to go to the project settings and

change the Use project groups option to No manually.
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5.11  Customizing Creo user interface

If you want to customize the user interface of Creo, go in Creo to File > Options >

Configuration editor. 

Changes made in Creo will by default be saved in the file creo_parametric_customization.ui

in the directory %PTC_WF_ROOT%\.Settings, e. g. %APPDATA%

\PTC\ProEngineer\creo4\.Settings.

Alternatively, you can have this file stored in the startup directory. To do so, select a group in

GENIUS TOOLS Project Configurator and in Creo Settings > Write > Target Directories > Ui

file location select Start.

5.11.1  creo_parametric_customization.ui

The file creo_parametric_customization.ui (short: customization.ui) contains the settings for

the graphical user interface (UI) of Creo. 

To customize the user interface specific to a user or a group of users, do as follows:

1. Modify the settings for the user interface in Creo in File > Options > Configuration editor.

2. Copy the file creo_parametric_customization.ui that is saved in %PTC_WF_ROOT%

\.Settings by default. (The use of the startup directory as alternative storage location is

described in the previous chapter.)

3. Save the copied ui-file to one of these directories: userdata, users, projects, units or

standard. (See also Directory structure. ) In a subdirectory of unit, the UI file would, for

example, determine the Creo user interface for the named unit.

There is only one customization.ui file. Hence, GENIUS TOOLS Starter does not write several

separate files as it does for the config.pro-file (such as e. g. config_mapkey.pro which would

be written into one final config.pro-file). This is important because it means that one

customization.ui file cannot add configuration settings to an existing file, it can only

substitute another customization.ui.

The customization.ui file that is found first determines the Creo user interface. The call

hierarchy is as follows: 

10



93GENIUS TOOLS Starter 
 
                                                                                                                             © 2020 INNEO Solutions GmbH

GENIUS TOOLS Project Configurator

1. userdata > 2. users > 3. projects > 4. units > 5. standard

Company-wide configuration with

creo_parametric_admin_customization.ui

The administrator can set up a configuration that is valid for the whole company or for

specific users, projects or units. To do so, change the name of the ui-file that is automatically

saved by Creo from creo_parametric_customization.ui to

creo_parametric_admin_customization and save it to one of these directories: userdata,

user, project, unit oder standard. 

The settings in the admin file creo_parametric_admin_customization are overwritten or

complemented by those in the individual  creo_parametric_customization.ui.

Executing the file creo_parametric_admin_customization.ui follows a hierarchical search in

these directories: 

1. users > 2. projects > 3. units > 4. standard

The administrator can thus set up a standardized graphical user interface for specific users,

projects and units, as well as a company-wide UI configuration.

Please note: A company standard, i. e. a UI file in the standard directory, can only be

implemented if there are no admin_customization.ui files in the directories users, projects

and units.

Individual customization.ui file

A user can manage his or her own customization.ui file by saving it to a directory userdata

to which the user needs write access. There are two possibilities. One, the user can access

the  userdata directory in the caddepot directory of the administration computer – from

where it will be synchronized to the client computer. Two, a directory can be created in any

location on the client computer. There, it does not undergo data synchronization. (See also

the chapter on User-driven configuration .)

The administrator can determine the storage location of the userdata directory in

Configuration > (select) group > Creo Settings > Application > User Settings >

Configuration folder. 

13
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u User settings

Configuration folder

The configuration files of each user can be stored in the directory userdata.

User config.pro

Name of a user-defined config.pro file. It is appended to the config_*.pro files in the users,

projects, units and/or standard directories.

User customization.ui

Name of a user-defined customization.ui file. It replaces any customization.ui file in the

users, projects, units and/or standard directories.

Security mechanism with GENIUS TOOLS Starter App

You can create a backup file (BAK file) from creo_parametric_admin_customization.ui in

GENIUS TOOLS Starter App. This can be useful for users who manage their own UI

configuration files, as well as for administrators who modify Creo UI settings for test

purposes.

1. In the info pane of GENIUS TOOLS Starter App go to the Config tab and click backup user

customization.ui

2. If a backup file already exists, confirm that it should be replaced.

3. In the following dialog box select whether creo_parametric_customization.ui should be

deleted.

Result: The file will be saved as creo_parametric_customization.ui.bak in the directory %

PTC_WF_ROOT%\.Settings. 

In order to restore the user-specific UI file:

1. Click on restore user customization.ui 

2. In the following dialog box select whether the backup file should be deleted. 

Result: The file creo_parametric_customization.ui.bak in the directory %PTC_WF_ROOT%

\.Settings is changed to creo_parametric_customization.ui.

5.12  Working with configuration and batch files

The following section explains how configuration files and supported batch files are used. It

is especially important to know in which sequence the files are processed, as this has a huge

impact on the resulting configuration settings.
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Configuration files are files defining settings for a Creo application. There are four types of

configuration files:  config.pro, customization.ui, config.sup and config.val (see also

Configuration files .)

Batch files are files that are used to carry out configuration instructions at different moments

(see also Configuring an operating environment with batch files ).

5.12.1  Call hierarchy

Configuration files and batch files are subject to the same call hierarchy. Unlike

configuration files, batch files cannot be saved in the searchmode directory.

Call hierarchy for batch and configuration files in a

started project

The following search and call sequence applies to configuration files.

1. Standard (global directory)

2. Standard searchmode, if Windchill is active

3. Unit (individual unit subdirectory

4. Unit searchmode, if Windchill is active

5. Project (individual project subdirectory)

6. Project searchmode, if Windchill is active

7. User (individual user subdirectory)

8. User searchmode, if Windchill is active

9. Userdata (configurable)

Warning: Starting with GENIUS TOOLS Starter 6.0.1, a new configuration mechanism is

in use. When you update from version 6.0.0.0 or migrate from Startup TOOLS 20xx, the

files in the projects directory, that is, the general configuration files, will be moved to a

new directory named standard. Project-specific configuration files located in

subdirectories under projects will not be moved.

11
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Example project configuration

The following graphic illustrates the call hierarchy for user C Meier starting Project 1 in the

unit Deutschland.

5.12.2  Searchmode directory

The searchmode directory is part of the calll hierarchy when you are working with Windchill.

It contains additional settings that are defined on starting Windchill, as well as commented-

out settings for Creo projects. Commenten-out settings are located in the file exclude.txt.

As soon as Windchill is activated, the searchmode directories within all configuration

directories relevant to a project will also be included into the configuration call hierarchy. All

configuration files within the searchmode directories will be used.

Please note: It can be useful to add a special directory under a project directory. If you

create a special directory called SEARCHMODE within a project directory, this directory

will also be used in determining the configuration settings.

Searchmode directories are used according to the same hierarchy as configuration files:

1. in the standard directory

2. in the unit directory

3. in the project directories

4. in the user directory
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5.12.3  Configuring an operating environment with batch

files

If you want to execute additional instructions before Creo is started or when Creo is stopped,

you can place project-specific batch files in the directory ..

\configuration\projects\<PROJECT>. The batch files names have to start with one of the

prefixes prestart_, start_ or stop_. You can use batch files to set additional environment

variables or copy additional data.

Warning: Starting with GENIUS TOOLS Starter 6.0.1, a new configuration mechanism is

in use. When you update from version 6.0.0.0 or migrate from Startup TOOLS 20xx, verify

references to configuration files in your batch files. References to 

..\configuration\projects\ have to be changed to ..\configuration\standard.

Batch files in the project-specific subdirectories under projects do not have to be changed.

Types of batch files

Prefix Start time Comment

prestart_ Started before the Creo

Parametric configuration in

created

When a project is started, GENIUS TOOLS

Starter calls the prestart_ batch files before

the config.pro files for the project are

assembled.

start_ Started before Creo

Parametric is started

When a project is started, GENIUS TOOLS

Starter assembles the config.pro files for the

project, then calls the start_ batch files.

stop_ Started after Creo

Parametric is closed

Please note that Enable stop batches has to

be set to Yes in the Project Configurator

under Configuration > (Select group) > Creo

Settings > Startup Settings.

Warning: The batch file types runonce_ and env_ are not supported any longer. If you

want to keep using your batch files, rename them to start_, e.g., env_inneo.bat to

start_inneo.bat

User or computer specific batch files

GENIUS TOOLS Starter can call batch files depending on which user, user group, computer,

or computer group is used to start a project. You can use the same types of batch files, i.e.,

prestart, start and stop. User specific batch files are marked by a prefix of
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U_<WindowsUserName>_. Computer specific batch files are marked by a prefix of

C_<WindowsComputerName>_.

Computer and user groups are specified by a prefix CG_<GroupName>_ or

UG_<GroupName>_.

Examples for the naming of user or computer specific scripts:
– U_JDOE_stop_copy_workspace.bat 

– C_CAD13_start_map_drive.bat

Examples for the naming of scripts specific to user or computer groups:
– UG_GroupA_start_copy_special_config.bat 

– CG_ CREO ON C_start_set_buw.bat

Please note: Avoid using special characters in group names! Special characters will be

removed, for example turning Creo on C: into Creo on C without the colon.

Warning: What if Creo Parametric does not start? The most common cause is that a

batch file causes the Creo call to stop. If there are start issues, first check which batch file

could cause the Creo call to stop.

5.13  Working with Windchill

GENIUS TOOLS Starter can be used in conjunction with Windchill. The following section

describes requirements and considerations for working with Windchill.

If you want GENIUS TOOLS Starter to look for Creo data in Windchill first, and in the project

directories in the second place, you should set your system settings to Using Windchill. To

do so, go to Configuration > Standard > Windchill settings > General > Using Windchill >

Yes.

You also need to set search paths for all library directories and load them when Windchill is

used, as long as not all Creo data has been transferred from disk storage to Windchill. There

is a template config_searchpath.pro file in the SEARCHMODE directory under the project

directory: 

<GTS-OperatingEnv>\configuration\projects\<ProjectDir>\SEARCHMODE. You can adapt

this template file to your setup.
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5.13.1  Object search hierarchy in Creo

Creo looks for objects in the following order:

1. Creo session

2. Search or call directory in which the parent object has been found, or directory which is

specified in the Open dialog.

3. Active Windchill workspace.

4. Active Windchill commonspace

5. Local working directory

6. Search paths

(See http://www.ptc.com/appserver/cs/view/solution.jsp?n=131190.)

5.13.2  Using a Windchill library

You can define dedicated directories for libraries, drawing frames, start objects and UDF in

Creo. When you are using Windchill, these directories can point to products or libraries in

the Windchill environment. The required syntax of the config.pro entry is as follows, using

the library directory of Windchill PDMLink as an example.

Pro_library_dir wtpub://<Windchill_server>/<Context>/<Directory>

– wtpub: refers to the Windchill commonspace

– <Windchill server>: name of the Windchill server as registered in Creo

– <Context>: context you want to refer to, e.g., SUT libraries

– <Directory>: directory within the context

Each user can define their own name for the Windchill server. This means that the general

config.pro entry cannot point unequivocally to a storage location, as maybe not all users

have used the same name when first registering the server. The following section describes

how GENIUS TOOLS Starter can be used to influence Windchill server naming.

5.13.3  Automatic Windchill server rename

In the general Windchill settings in GENIUS TOOLS Project Configurator, you can define a

Windchill server name that should be used system-wide (Configuration > Standard >

Windchill settings > General > Windchill server name). To link this name with an existing,

manually configured Windchill server, you also have to make two other settings:

1. Windchill server URL: address of the Windchill server

2. Server auto rename: Yes (under Register)

http://www.ptc.com/appserver/cs/view/solution.jsp?n=131190
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If a server is found under the URL you have specified for the Windchill server, this server will

be renamed to the specified name on the next Creo start.

5.13.4  Automatic Windchill server registration

The Windchill server registration enables the automatic registration of a Windchill server

under a given name in PTC Creo.

The concept of automatic server registration is that previously registered servers are

retained without changing the entire registration and that a newly registered server is set to

active. It is also part of the concept that server registration does not result in the registered

server reverting to active as soon as a project with the corresponding configuration is

selected. Usually the user wants Windchill settings of the previous Creo session to be set

again after restarting Creo.

Users who are to get access to a Windchill server via automatic server registration need to

have a valid Windchill account and have access to the defined workspace in the defined

Windchill context. It can be useful to create a context (product, library or project) that is not

otherwise used and that these users have access to.

Please note: In order to use automatic server registration, the following requirements

must be met:

– Using Windchill must be activated.

– The Windchill Context must be set and must exist.

– The default workspace must be located in the Windchill Context that is given.

– The Windchill cache directory must be a subdirectory of the Windchill user root folder.

Automatic server registration is configured under configuration > (Select group) > Windchill

settings. The Windchill settings are expanded once you set Use Windchill to Yes.

u General

Use Windchill

Activate/deactivate the Windchill server.

Yes: Activates Windchill-relevant settings such as automatic server registration.

No: Windchill settings will be disregarded.

No, don't register: The Creo session is started without an active Windchill server.

However, the Windchill server remains in the server registry without being selected.

Windchill server name

Specify the name with which the server will be registered in Creo.

Windchill server URL

Specify the URL under which the server can be reached.
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u Register

Server auto register

Select whether the server should be registered automatically.

Yes: The above mentioned Windchill server is automatically registered and is then

available within Creo.

No: The server is not entered automatically.

Server auto rename

If a server already exists at Windchill server URL and has a different name than Windchill

server name, the server will be renamed when starting Creo next.

Set Windchill server online

Select whether the server should be put online.

Yes: A new server that was added by auto-registration will automatically be put online.

No: The server is registered offline.

u Windchill context

Default workspace name

Name of the workspace that is active during registration. The default workspace has to be

present under the context given.

Windchill context type

Type of context: Product, Library, Project.

Windchill context

Context of the workspace.

5.13.5  Project-specific Windchill settings

You can also define a Windchill server to be used for a specific project. To do so, go to the

Projects page, select the desired project and make the project-specific Windchill settings in

the Windchill tab.

See also Workspace for Windchill .

5.14  Access rights

The following access rights for software functionality can be assigned to users or groups

1. GENIUS TOOLS Starter App:

– Can enter Project Configurator

– Can pause synchronization

– Prevent switch to local installation

– Can see licenses
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– Can borrow licenses

– Can disable Creo config files

– Can see auto projects

For users that do not have a function access right, the corresponding control is not displayed

in the UI of GENIUS TOOLS Starter App. For more information on the GENIUS TOOLS

Starter App UI, please refer to User interface .

2. GENIUS TOOLS FOR CREO

– Is GTfC admin

– Prevent switch to local installation

Please note: Not every functionality can be controlled using access rights. GENIUS

TOOLS Starter can be started without an express permission, and a project that is visible

to a user can always be started by that user

For a description of the individual rights, please refer to Assigning access rights .

5.14.1  Creating function access groups

Use function access groups to manage access rights for individual users or for groups. The

function access groups Everyone (3) and Administrator (4) are pre-configured defaults.

Everyone contains all Windows users known to the system, even if they have not yet been

configured in Project Configurator. This groups is created automatically to avoid having to

manually enter every user in Project Configurator.

Anyone who starts GENIUS TOOLS Starter from the Caddepot can use the function access

group Administrator. 

Please note: The function access groups Everyone and Administrator have to be

considered separately when updating to GENIUS TOOLS Starter 6.0.1 or migrating from a

Startup TOOLS environment. Please refer to the release information.
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To create a new function access group, select Function access (1), then click Create. Under

Details, enter a name and, optionally, a comment for the new group. For visualization of

group assignment in the user view (Resources > Users), you can specify a color for the

group.

Each function access group has to have an assigned role (6). You can give the function

access group the same name as the role for an easy grasp.

A role groups users or computers. To create a role, got to Resources > Roles. By default, the

role Everyone is assigned to the function access group Everyone, and the role Administrator

to the function access group Administrator.

Please note: A user can be assigned to multiple groups or roles. In this case, the user will

have all rights granted by their groups or roles, meaning that a right will not be revoked

by an assignment to another group that does not have this right.

u Members

Role

Assign a role. To create new roles, go to Resources > Roles.

u LDAP  – User – Computer

This section shows the users and computers assigned to the role. To assign elements to a

role, go to Resources > Roles > Select role. 
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If the checkbox before the user or computer name is set, the corresponding user or

computer is locked. To make changes to the lock status, go to Resources > Users > Create or

edit user, or to Resources > Roles > Select role > LDAP. (See also Block users or

computers .)

Add user

Add users to the group to give the group's rights to them.

5.14.2  Assigning access rights

To assign access rights to a function access group, select the group under Access right >

Function access. Edit the settings under Function access.

u Function access

Can enter Project Configurator

The user may open GENIUS TOOLS Project Configurator. For users who do not have this

right, a message will be displayed, and the Project Configurator will be closed when the user

confirm the message.

Default for group Administrator: Yes

Default for group Everyone: No

Hint: When GENIUS TOOLS Starter is started locally from the Caddepot directory, Project

Configurator is always accessible. In this way, an administrator will always have access to

the configuration.

Please note: If this right is not assigned to any user, GENIUS TOOLS Project

Configurator will revert to the default setting of granting the right to all uesers.

Can pause synchronization

The user may pause the automatic data synchronization. Synchronization has to be paused if

you want to make changes to files in the Cadpool locally, otherwise local changes would be

overwritten as soon as the synchronization runs.

Default for group Administrator: Yes

Default for group Everyone: No

Warning: GENIUS TOOLS Starter App will keep the synchronization on pause even after

a restart of the software as long as the user still has this right. If this right is withdrawn

while the synchronization is paused, the synchronization will run automatically when the

software is restarted, which may result in data loss from the Cadpool directory.

Is GTfC admin

The user can access the editors in the GENIUS TOOLS for Creo (GTfC).

Default for group Administrator: Yes

Default for group Everyone: No
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Prevent switch to local installation

By default, if the GENIUS TOOLS Starter App is started from the Caddepot directory on the

administration computer, GENIUS TOOLS Starter App will switch automatically to the local

Cadpool. If Prevent switch to local installation is set to Yes, there is no automatic switch and

the user can work on the data in the Caddepot.

Default for all groups: No

Warning: If this right is granted to a user before the initial synchronization, GENIUS

TOOLS Starter App will not be installed locally for this user, and the user will not be able

to start locally.

Can see licenses

The user can see the license statistics in GENIUS TOOLS Starter App. To use this option, you

also have to set Show licenses under Configuration > GENIUS TOOLS Starter App > Licenses

> Show licenses to Yes.

Default for group Administrator: No

Default for group Everyone: Yes

Can borrow licenses

The user can access the functionality for borrowing licenses in GENIUS TOOLS Starter App.

To use this option, also set Can see licenses to Yes.

GENIUS TOOLS Starter App will borrow the Startup TOOLS license, then start the borrowing

process for PTC. The PTC borrowing process will borrow the Creo and GENIUS TOOLS for

Creo licenses.

Default for group Administrator: No

Default for group Everyone: Yes

Warning: To borrow the PTC licenses, the user has to complete the PTC borrowing

process.

Can disable Creo config files

The user can temporarily disable configuration files for a project. Disabled files will not be

used by GENIUS TOOLS Starter App when creating the configuration settings.

Default for group Administrator: No

Default for group Everyone: Yes

Warning: Disabled configuration files will become active again on the next project

validation or synchronization.

Hint: This right makes it possible to quickly disable configuration files on individual

computers without having to change company-wide configuration settings.

Can see auto projects

GENIUS TOOLS Starter will search for other supported applications on the local application

computer, for example Keyshot or Creo Elements / Creo Direct. The applications can be
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started from GENIUS TOOLS Starter App. However, it is not possible to configure the auto

projects.

Default for group Administrator: No

Default for group Everyone: Yes

Please note: Licenses for auto projects cannot be checked by GENIUS TOOLS Starter.

5.15  Settings for GENIUS TOOLS Starter App

This section explains how to configure GENIUS TOOLS Starter App for the users. Settings for

GENIUS TOOLS Starter App are made from Project Configurator. In addition, as an

administrator, you can send messages to the users that will be displayed via the message

symbol  in the GENIUS TOOLS Starter App sidebar.

5.15.1  Configuring the desktop link

By default, a desktop link for GENIUS TOOLS Starter App is created automatically on the

application computers. You can define the properties of this desktop link in Project

Configurator, including centrally-defined start parameters.

To configure the desktop link, go to the Configuration page , select a group, then select

the settings item GENIUS TOOLS Starter App. Set Create desktop link to Yes. This setting

determines that the desktop link is created or updated according to the configuration with

each program start or synchronization process.

You can define the following settings for the desktop link.

Name

You can define a name for the desktop link. Without an entry the desktop link will be named

GENIUS TOOLS Starter App - <operating environment name>.

Execution path

Enter the path GENIUS TOOLS Starter App should be run in.
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Commandline arguments

Enter any start parameters that should be used by GENIUS TOOLS Starter App.

Warning: If you used start parameters in version 6.0.0, take care to move them to this

setting in Project Configurator. If the start parameters are not specified here, start

parameters in local links will be deleted!

Warning: If the start icon is located in the users\public\desktop directory, it cannot be

changed with user access rights. This means that the central icon definition cannot be

applied!

Custom icon graphic

If you want to use a custom icon graphic, you have to place the image file in the _Images

directory of the operating environment using the file name

<operating_environment_name>.ico.

Example result

5.15.2  Support link and logging

Under GENIUS TOOLS Starter App > General, you can define whether users should have

access to the online support function (TeamViewer). This setting displays or hides the

TeamViewer symbol  in the sidebar of GENIUS TOOLS Starter App.

u General

Hide support

Hides the TeamViewer icon in the GENIUS TOOLS Starter App.

Yes: The user sees the TeamViewer icon.

No: The TeamViewer icon is not visible.

Log projects without permission

Projects to which a user has no access rights are by default not displayed in the log file.

Yes: Information about the projects is displayed in the log file.

No (Default): Projects are not included in the log file.

Write crash report to Caddepot directory

Unexpected errors are written to a log file by GENIUS TOOLS Starter App (gts_error.log). The

file can also be copied to the server and is saved there as

serveronly\_ErrorLog\<Computer_name>.log.
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Yes: The client will copy its log file if an unexpected error occurs.

No (Default): The log file is only available on the client computer.

5.15.3  Information pane

The information pane is on the right of the user interface of GENIUS TOOLS Starter App. It

contains the tabs Info, Licences and Config. A fourth tab, Error, is displayed if an error has

occurred and shows error log information. (See also chapter GENIUS TOOLS Starter App >

Information pane. ) 

As for some of the information in these tabs, the administrator can choose to display or hide

them to users. This is configured in GENIUS TOOS Project Configurator and will be

explained in the following chapters. 
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5.15.3.1  Info tab

The Info tab contains the following:

Benutzerinformationen: user name, project

name, project directory, data directory,

working directory, the desktop application

and the PSF key used for this project, the

language in which Creo starts the project, and

the use of Windchill.

In the info tab a user can select the language

in which the project start, if he has an access

right. This is granted by the administrator in

Configuration > (select) group > GENIUS

TOOLS Starter App > Projects > Creo

language selectable in GENIUS TOOLS Starter

App. (See also chapter on Project settings:

warnings and language .)

5.15.3.2  Licenses tab

Under GENIUS TOOLS Starter App > Licenses, you can define which license information will

be displayed to users in the GENIUS TOOLS Starter App Information pane  under the

Licenses tab.

u Licenses

Show licenses

Specifies whether the number of available licenses is displayed in GENIUS TOOLS Starter

App.

112
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Yes: The client obtains the license status for Creo projects. This can prolong the

validation of a project, depending on the response time of the PTC license server.

No: The license status for Creo projects is not established.  The settings Get extensions,

Calculate licenses by extension and Identify license users will not be used.

PTC license reusable per host

State whether your PTC licenses can be used several times.

Yes: Use this option if you have DUP_GROUP in your PTC license file. The license

validation will calculate the free PTC licenses in a way that PTC licenses that are already

in use by another session on the same application computer will show an amount of at

least one, making the project valid.

No: Use this option if you are unsure or cannot find DUP_GROUP in your PTC license

file.

Please note: For this option to produce the correct result, the PTC license must contain

the keyword DUP_GROUP according to CS234779. This information cannot be

determined by GENIUS TOOLS Starter App.

Get extensions

Define whether extensions should be queried. To use this setting, Show licenses has to be set

to Yes.

Yes: In addition to the basic license, extensions are also queried on the license server.

No: Only the basic license is queried.

Calculate licenses by extensions

Define whether a free license is calculated based on the basic license or on extensions. To

use this setting, Get extensions has to be set to Yes.

Yes: Extensions are also used for license calculation.

No: Licenses are calculated on the basic license.

Identify license users 

Define whether users of a license are identified.

Yes: User names are displayed on the client as a tooltip of the corresponding license

name. The Windows user name is replaced by the GENIUS TOOLS Starter alias.

No: No user names are obtained or displayed.

Please note: If the alias should be displayed, the users have to be configured under

Resources > Users. Otherwise, the Windows user name will be displayed.

Timeout for FlexNET server

Enter a maximum duration for the license query in seconds. The license servers are pinged

before the license query is started. If a server does not react within the specified time, is is

not considered in license calculation.
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The duration you enter is also used as a maximum time for the license query.

If you expect licenses to be unavailable form time to time, set the timeout to 0, which means

that there is no timeout specified.

Default: 0 (no timeout specified)

5.15.3.3  Config tab

The Config tab shows the user which configuration files are used for configuring the project

and in which directories these files are stored. 

Der Konfig-Tab in GENIUS TOOLS

Starter App

There is also the button backup customization.ui, which

creates a backup copy of the user-specific file

customization.ui, which contains settings for the user

interface of Creo. (More information in Security

mechanism with GENIUS TOOLS Starter App.)

User can deactivate any of the listed configuration files,

if they are granted the right to do so by the

administrator. This right can be granted by switching

the radio button Can disable Creo config files to Yes in

Access rights > Function access > (select) access group

> Function access.

Settings in GENIUS TOOLS Project

Configurator
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5.15.4  Project settings: warnings and language

Under Configuration > Group (select) > GENIUS TOOLS Starter App > Projects, you can

configure how projects should be displayed in the project list if there is no license available

or if there are license extensions missing. Also, you can define whether users can change a

project's Creo language.

u Projects

Display invalid projects

Specifies how projects with missing licenses are displayed to the user. To use this setting,

Show licenses has to be set to Yes.

No: Projects without a valid license are hidden.

Yes, as warning: Projects without a valid license are displayed with a yellow

background and can be started regardless.

Yes, as error (Default): Projects without a valid license are displayed with a red

background and cannot be started.

Yes, deactivated: Projects without a valid license are displayed with a gray background

and cannot be started or selected.

Please note: Projects for which no corresponding Creo version can be found are never

displayed. In case the Creo version is found, but no PSF key, you can choose between not

displaying the project and displaying it as warning, see Assigning Creo licenses to

projects.

Creo language selectable in GENIUS TOOLS Starter App

Specify whether users are allowed to change the language of Creo. If this option is set,

GENIUS TOOLS Starter App displays a language selection control to the users.

Please note: This option will only have an effect if the language is not set explicitly for

the project. Also, the selected language has to be available in the Creo installation used.

This is not checked by GENIUS TOOLS Starter.

Yes: The user has the possibility to change the language of a project.

No: The user cannot change the default language.

5.15.5  Operating environment clean-up

Under GENIUS TOOLS Starter App > Cleanup of working environment, you can define

whether an outdated operating environment should be deleted from the application

computers, that is, from the Cadpool directories. The operating environment in the

Caddepot is not affected. The user is asked to confirm before the deletion process is started.
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5.15.6  Sending messages to the users

GENIUS TOOLS Starter includes a functionality for administrators to send messages to the

users. The messages are displayed to the users as a text document on starting GENIUS

TOOLS Starter App or on synchronization.

Sending a message to the users

Step 1: Go to the operating environment's _Information directory.

Step 2: Create a simple text (TXT) file with your message. The name of the text file has to

start with the prefix alert_, e.g., alert_message.txt.

You can also use a PDF file with the file name prefix alert_.

All documents marked with the alert_ prefix will be displayed once automatically on

synchronization. Afterwards, users can access the documents by clicking on the message

symbol  in the GENIUS TOOLS Starter App sidebar .

Whenever you make a change to a message document, it will automatically be displayed to

the users again.
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6  GENIUS TOOLS Starter App

GENIUS TOOLS Starter App lists the projects defined in GENIUS TOOLS Project Configurator

and lets the users start them.

If changes are made to the central configuration, these changes are taken up by GENIUS

TOOLS Starter App with the next synchronization.

6.1  Starting GENIUS TOOLS Starter App

By default, GENIUS TOOLS Starter App is configured to start automatically with the

operating system. GENIUS TOOLS Starter App is displayed in the Windows task bar and can

be called up from there.

If GENIUS TOOLS Starter App is not started automatically, the app can be started via a

centrally configurable desktop link.

Please note: To close GENIUS TOOLS Starter App, select Exit in the user menu . When

you click Close, the window is minimized.

6.2  User interface

GENIUS TOOLS Starter App comes with a clearly structured user interface. Depending on

the configuration, for example, license information on the PTC products configured for each

project is listed in the UI.

For a description of the information displayed in the right pane, please refer to Information

pane .

Project selection

The left pane shows the available desktop applications.

Select the desired application, e.g., Creo Parametric. The projects configured for the selected

application are displayed in the middle pane.

Double-click to start the desired project. The desktop application is started using the

configuration defined for the selected project.

License check for projects

In GENIUS TOOLS Project Configurator, your administrator can define whether GENIUS

TOOLS Starter App should check for available Creo licenses on start, and how projects
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should be displayed if there is no license available for them. Projects without a license can

be treated as follows:

– do not display: The projects are not visible for the user.

– display: The projects are marked with a red background and cannot be started.

– display as inactive: The projects are marked with a gray background and cannot be started.

– display with warnings. The projects are marked with a yellow background and can be

started.

Project selection in GENIUS TOOLS Starter App

6.3  Information pane

The rightmost pane in GENIUS TOOLS Starter App contains general information on the user,

the configured projects and the licenses used. The information is presented in the tabs

described below.

Error

The Error tab is only displayed if an error has occurred and shows error log information.

Info

The Info tab contains information on the current user and on the selected project.

User information:

– The user is identified by their GTS alias. If no GTS alias has been specified, the Windows

user name is displayed.

– The user image sized 100 x 130 px has to be located in the directory \userdata\%

USERNAME% under the file name %USERNAME%.png.

Project information:
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– Project name

– Project folder

– Data folder

– Working directory

– Application: the desktop applications used for this project

– Start command: the PSF key used for this project

– Application language: the language in which Creo starts this project. The administrator can

give a user the right to choose the language. (See Project settings: warnings and

language .)

– Windchill

Licenses

The Licenses tab contains information on the license servers used and on available licenses

and may look like following screenshot:

If you are working with borrowed licenses and without synchronization, the Licenses tab is

hidden. If you are working with borrowed licenses, empty information tables are hidden.

Please note: If you are running Creo Parametric on your local computer, using one

license, and there are no other licenses available on the license server, the number of free

licenses is given as 1, not 0. Also, the hint Multiple usage is displayed. This type of listing

is meant to show that you can start additional instances of Creo because doing so does

not require additional licenses.

The administrator defines which information on licenses is displayed to the user. (See

chapter Settings for GENIUS TOOLS Starter App > Licenses tab .)

If a user is permitted to borrow licenses, the button Borrow is displayed.
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Borrowing licenses

1. In the Licenses tab, click Borrow. The Borrow licenses dialog is displayed.

2. Select the number of days for which you want to borrow the licenses and click Borrow.

GENIUS TOOLS Starter App borrows the licenses and the Creo license borrowing dialog

is displayed.

3. In the Creo license borrowing dialog, select the required start key and the borrowing

term in days and click Start. Creo is started with the borrowed licenses.

Returning licenses

To return borrowed Startup TOOLS licenses, select Return borrowed licenses in the user

menu .

Config

The Config tab contains information on the config.pro files and additional applications used

in the selected project.

Your administrator defines whether you can deactivate the use of individual configuration

files in the Config tab. (See chapter Settings for GENIUS TOOLS Starter App > Config tab .)

To deactivate a configuration file, remove the check mark from the check box for the desired

file.

You can create a backup copy of the user-specific file customization.ui, which contains

settings for the user interface of Creo. To do so, click Backup customization.ui. To restore the

customization.ui from a backup copy, click Restore customization.ui. For more information

consult Security mechanism with GENIUS TOOLS Starter App.
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6.4  Working with units

When you are using a subscription license, units can be defined as an additional

configuration layer to reflect different company branches or divisions. (See chapter

Configuring heterogeneous environments. )

If units are used in your environment, the current unit is displayed in the header of GENIUS

TOOLS Starter App.

Unit

information in

the header

If a user account is assigned to multiple units, the user can switch between units via the

header.

Unit selection

Units are displayed in alphabetical order unless a unit is defined to be the first on the list.

This can be specified in GENIUS TOOLS Project Configurator by inserting a space character

in front of the unit name. (See Displaying units in GENIUS TOOLS Starter App. )

6.5  User menu

To access the user menu, click on the gear symbol in the header .

Language: user interface language

You can switch the user interface language between German and English at any time. The

language setting is saved and will be used the next time you start the software.

The software first starts with a German user interface if the operating system locale is set to

German. For all other locale settings, the software first starts with an English user interface.

Theme: user interface color settings

The software comes with the color themes Blue, Light and Dark. You can switch themes at

66
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any time. The theme setting is saved and will be used the next time you start the software.

Synchronize now (F8)

GENIUS TOOLS Starter immediately synchronizes from the central Caddepot, regardless of

the specified synchronization interval, and loads any updated files into the Cadpool.

Pause synchronization (F7)

GENIUS TOOLS Starter stops synchronization until it is re-started by the user. The setting

Pause synchronization is saved for the next start and marked by a yellow bar below the

header. When the user resumes synchronization, they are asked whether they want to

resume and overwrite local changes.

Pause synchronization if you want to prevent local changes from being overwritten until

they have been added to the Caddepot by your administrator.

Please note: Your administrator defines whether you can pause the synchronization. If

you are not allowed to pause the synchronization, the item Pause synchronization is not

displayed in the menu.

Project Configurator (F8)

Opens GENIUS TOOLS Project Configurator.

Please note: Your administrator defines whether you can access GENIUS TOOLS Project

Configurator via the access rights . If you are denied access, the item GENIUS TOOLS

Project Configurator is not displayed in the menu.

6.6  Sidebar

The sidebar contains the functions Refresh Projects , Message from Administrator ,

Open log file , Open Home  and Online help .

Refresh Projects (F5)

Refresh Projects reloads all project configurations from the administration computer in the

same way as when you restart the application.

Message from Administrator (F4) 

New messages from your administrator will be displayed once automatically after

synchronization. If you want to reread a message later on, click on the letter symbol in the

sidebar. Administrator messages are saved as text files in the _Information directory, see

also Sending messages to the users .

101

113



120GENIUS TOOLS Starter 
 
                                                                                                                             © 2020 INNEO Solutions GmbH

GENIUS TOOLS Starter App

Open log file

Opens the log file that is written on each project start. The log file is saved in the application

computers user directory.

Please note: Please always find and check your log file before opening a call with the

support hotline. The log file is required for troubleshooting any issues.

Open home

Opens the user directory in the file manager.

Online help

Online help opens an internet link to the INNEO Teamviewer software for remote support.

6.7  Footer

License mode

The GENIUS TOOLS Starter App footer shows the current license mode by displaying an

icon.

– full version 

– borrowed license 

– failsafe mode 

– educational or home use 

Synchronization mode and synchronization status

To the right of the icon for the license mode, information on the synchronization mode is

displayed. For more information, please refer to Procedures and synchronization .

– Synchronization is active 

Hover the mouse on the synchronization symbol to see the paths to the Caddepot and to

the local operating environment as a tooltip.

– local operating environment without synchronization 

– synchronization of toolkit applications is paused as long as Creo is running 

The synchronization status with the date and time of the last synchronization is displayed in

the middle area of the footer.

8
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Application icon

As long as a supported desktop application is running, the application icon is displayed in

the footer.
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7  GENIUS TOOLS product overview

This chapter provides graphics showing the modules and products of the GENIUS TOOLS

product family.
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7.1  GENIUS TOOLS product family

GENIUS TOOLS products with

Startup TOOLS 6.0. and later versions.
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7.2  Startup TOOLS product development

Development of Startup TOOLS from an integrated to a modular product.
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8  Glossary

Administration computer

Computer on which the administrative user has full write access to the Caddepot directory

in order to manage all data on the file system level.

Application computer, workstation

Computer on which the (Creo) user works. The application computer houses the Cadpool

directory, which contains the local operating environment.

Creo

CAD software by PTC with the applications Creo Parametric, Creo Elements, Creo Direct.

Cadpool

Directory on the application computer that contains the local operating environments. The

Cadpool directory is synchronized from the Caddepot.

Caddepot

Directory on the administration computer that contains the central operating environment.

Client

Term for application computers for Startup TOOLS versions up to 2018.

Computer group

A defined group of configured Windows computers. Contains settings in which the

computers' configuration differs from the general system-wide configuration.

Configuration file

File which determines settings for a Creo application. There are four types of configuration

file: config.pro, customization.ui, config.sup and config.val.

config.pro file

Most important Creo configuration file, defines user settings.

config_*.pro files

Configuration files in GENIUS TOOLS Starter, e.g., config_sut_de_c5p_mapkeys.pro, that

are assembled to form a config.pro file.

config.sup file

Creo configuration file which contains settings that cannot be changed by the users, e.g., to

ensure drawing standards.

config.val file

Creo configuration file which contains validation settings for data import.
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customization.ui file

Creo configuration file which contains user interface customizations for a user.

Data directory

Main directory for all data related to an operating environment at <GTS-

OperatingEnv>\data.

Educational license

License for academic institutions.

GENIUS TOOLS

Family of software products by INNEO Solutions GmbH, including Startup TOOLS, Model

Processor, and freeware tools such as Purge.

GENIUS TOOLS for Creo

Component of the Startup TOOLS software product which contains functional

enhancements for Creo.

GENIUS TOOLS Environment Administrator

Stand-alone administrative tool. It is used to create and update work environments, edit

work environment properties and migrate from older versions of Startup TOOLS to

version 6 and later. GENIUS TOOLS Environment Administrator is located at ...

\installdepot\gtsa-latest\gtsa-exe.

GENIUS TOOLS License Manager

Administrative tools for managing Startup TOOLS licenses.

GENIUS TOOLS Project Configurator 

Administrative component of GENIUS TOOLS Starter for managing project configurations

and other properties of an operating environment. Open GENIUS TOOLS Project

Configurator from the user menu of GENIUS TOOLS Starter App.

GENIUS TOOLS Starter

Software product consisting of the three components GENIUS TOOLS Project

Configurator, GENIUS TOOLS Starter App and GENIUS TOOLS Environment Administrator.

GENIUS TOOLS Starter App 

Stand-alone component of GENIUS TOOLS Starter which lets users start configured Creo

projects. GENIUS TOOLS Starter app is located in each operating environment under 

...\caddepot\lokal\software\GTS.exe. 

GTS

Abbreviation for GENIUS TOOLS Starter.

GTS.exe

Name of the executable file for GENIUS TOOLS Starter App.
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GTSA.exe

Name of the executable file for GENIUS TOOLS Environment Administrator.

GTS Alias

User alias in GENIUS TOOLS Starter, for use in additional applications for Creo. The GTS

alias is available as an environment variable (%GTS_USER%) in Creo. If you do not specify an

alias, the Windows user name will be used.

GTS Alias Long

Long user alias. The long alias is available in Creo via the environment variable %

GTS_USERLONG%.

GTS Alias Short

Short user alias. The short alias is available in Creo via the environment variable %

GTS_USERSHORT%.

Home Use license

License for private use.

Initial synchronization, initialization

First synchronization run which creates the Cadpool directory on the application computer

and synchronizes it with the Caddepot.

Installdepot

Subdirectory of the installation directory that contains the release and version setups

without settings and customizations. All setup programs unpack their data to this

directory.

Installation computer

Computer on which the setup programs are run. Typically, this is also the administration

computer.

LDAP (Lightweight Directory Access Protocol)

Network protocol for accessing a distributed directory service, e.g. the Windows user

management.

Mapkey

Macro defining a sequence of commands and functions which can be created in Creo to

simplify often-used procedures.

Mediadepot

Subdirectory of the installation directory. It contains setup files for different releases and

versions. All setup files will install or unpack to the Installdepot directory.

NAS (Network Attached Storage)

File server providing independent storage capacity in a network of computers.
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NC (Numerical Control)

Computer-based applications for controlling machine tools and production lines.

Operating environment

Directory that contains all the data required for working with the desktop application. This

includes configuration data, libraries, templates and additional applications. The operating

environment also contains a database with all configured projects.

Operating environment, local

Operating environment on the application computer.

Perpetual license, permanent license

License that allows using a defined version of a software for an unlimited period of time.

PDMLink

Component of the Windchill software product family that is used for product data

management.

PTC

The software company that develops Creo.

Project

Collection of configurable application properties such as project directory, data directory

and license, e.g. for Creo Parametric.

Project, blocked

Project that a user can neither access nor see in GENIUS TOOLS Starter App.

Projekt, hidden

Project that a user cannot see in GENIUS TOOLS Starter App, but is able to access it with a

transfer parameter.

Project, invalid

Project, for which a user has no valid license or required license extensions. Access to it an

display in GENIUS TOOLS Starter App can be configured.

Project directory

Directory for project data at <GTS-OperatingEnv>\configuration\projects\%

GTS_PROJECT_DIR%

Role

Group of users or computers that are assigned access rights to projects and GENIUS

TOOLS Starter App functionality.

User group

A defined group of configured Windows users. Contains settings in which the users'

configuration differs from the general system-wide configuration.
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Searchmode directory

Subdirectory of the directory Standard, Units, Projects or Users which is included into the

call hierarchy for configuration files and batch files if Windchill is active.

Startup TOOLS

Software product family that comprises the products GENIUS TOOLS Starter and GENIUS

TOOLS for Creo (GENIUS TOOLS Library, GENIUS TOOLS Parameter, GENIUS TOOLS

Quick Access), as well as Creo data packages and the GENIUS TOOLS License Manager.

Startup TOOLS Server

Term for the administration computer for Startup TOOLS versions up to 2018.

STOOLS

Root directory name for Startup TOOLS versions up to 2018.

SUT

Abbreviation for Startup TOOLS.

Synchronization

Functionality that copies the data of an operating environment in the Caddepot directory

to the Cadpool directory on an application computer.

Subscription license

License that allows using a software for a limited period of time.

TeamViewer

Third-party software used by INNEO Solutions GmbH to provide remote support.

UDF

Abbreviation for user-defined feature, a template for repeatedly required Creo features.

Unit

Group of users that belong to a company department defined either geographically or

organizationally. Users can be dynamically assigned to units using LDAP queries.

Windchill

Software product by PTC for managing product data over the entire product life cycle.
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